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Folien

Folienbereich
Eine mit Draw erstellte Zeichnung enthält eine oder mehrere Folien in einer Datei. Die Folien 
werden als Miniaturansicht im Folienbereich angezeigt, hier können Folien hinzugefügt, 
umbenannt, gelöscht und angeordnet werden. Der Folienbereich ist in der Voreinstellung links 
des Arbeitsbereichs angedockt und kann im Menü mit Ansicht > Folienbereich eingeblendet 
werden. Für eine detailliertere Beschreibung des Arbeitsbereiches siehe Handbuch Erste Schritte
Einführung in Draw und Abbildung 1. 

Der Folienbereich kann in ein schwebendes Fenster und wieder zurück verschoben werden. 
Dazu klicken und ziehen Sie die Titelleiste des Folienbereichs aus dem Hauptfenster heraus bzw.
wieder hinein oder halten Strg  gedrückt und doppelklicken auf die Titelleiste des Folienbereichs.

Durch Klicken auf eine Folie im Folienbereich wird die Folie im Arbeitsbereich dargestellt.

Der Folienbereich kann mit Klick auf das x in der Titelleiste des Folienbereichs oder im Menü mit 
Ansicht > Folienbereich ausgeblendet werden.

Abbildung 1: Draw Hauptfenster

Navigator

Im Menü mit Ansicht > Navigator oder mit der Taste F5  wird der Navigator als schwebendes 
Fenster geöffnet (Abbildung 2), in der Seitenleiste kann der Navigator durch Klick auf das 
Symbol  angezeigt werden.
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Im Navigator kann eine Folie durch Klicken im Arbeitsbereich sichtbar gemacht und darin 
enthaltene Objekte durch Klicken direkt ausgewählt werden. Dies ist insbesondere dann hilfreich,
wenn sich auf einer Folie viele Objekte gegenseitig verdecken oder überlappen.

Abbildung 2: Navigator

Folie wechseln
Die im Arbeitsbereich angezeigte Folie kann gewechselt werden:

• im Menü Folie > Navigieren und der Auswahl von Erste Folie, Vorherige Folie, Nächste 
Folie  oder Letzte Folie,

• durch Drücken der Tasten Pos1 , Bild auf , Bild ab  bzw. Ende ,

• im Navigator durch klicken auf die entsprechende Zeile.

Folien hinzufügen

Neue Folie hinzufügen
Eine neue Folie wird als nächste Folie hinter der aktuell im Arbeitsbereich angezeigten Folie 
hinzugefügt

• im Menü mit Folie > Neue Folie,

• im Arbeitsbereich über einen Rechtsklick an einer Position, an der kein Objekt liegt, und 
im Kontextmenü Auswahl Folie > Neue Folie,

• im Folienbereich über einen Rechtsklick und im Kontextmenü Auswahl Neue Folie, 

• im Menü mit Folie > Folie aus Datei einfügen.

Folie kopieren
Die Kopie einer Folie wird eingefügt

• im Menü mit Folie > Folie doppeln direkt hinter der aktuellen Folie,

• im Folienbereich über einen Rechtsklick und im Kontextmenü Auswahl Kopieren und 
danach an beliebiger Position im Kontextmenü und Auswahl Einfügen.

Folie umbenennen
Neue Folien werden in der Voreinstellung als Folie 1, Folie 2, Folie 3 etc. benannt und beim 
Ändern der Reihenfolge automatisch umbenannt. Eine Folie kann mit einem gewählten Namen 
versehen werden

• im Menü mit Folie > Folie umbenennen,
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• im Arbeitsbereich über einen Rechtsklick an einer Position, an der kein Objekt liegt, und 
im Kontextmenü Auswahl Folie > Folie umbenennen,

• im Folienbereich über einen Rechtsklick und im Kontextmenü Auswahl Folie 
umbenennen.

Reihenfolge ändern
Folien werden in ihrer Reihenfolge geändert

• im Menü Folie > Verschieben mit der Auswahl von Folie an Anfang, Folie nach oben, 
Folie nach unten oder Folie ans Ende,

• im Folienbereich mit Klicken auf die Folie und Ziehen an die neue Position.

Folie löschen
Gelöscht wird die aktuelle Folie

• im Menü mit Folie > Folie löschen,

• im Arbeitsbereich über einen Rechtsklick an einer Position, an der kein Objekt liegt, und 
im Kontextmenü Auswahl Folie > Folie löschen,

• im Folienbereich über einen Rechtsklick und im Kontextmenü Auswahl Folie löschen.

Hinweis

Das Löschen geschieht ohne Rückfrage, jedoch kann die Operation unmittelbar 
danach im Menü durch Bearbeiten > Rückgängig wieder hergestellt werden.

Kommentare
Zu einer Folie können Kommentare hinzugefügt werden. Kommentare werden nicht gedruckt. 

Ein Kommentar wird im Menü mit Einfügen > Kommentar angelegt, ein Kommentarfeld mit dem
Namenskürzel des Benutzers und einer Nummerierung wird dabei oben links auf der Folie 
dargestellt und ein Bearbeitungsfenster geöffnet. 

Im Bearbeitungsfenster sind unten links Name und Datum dargestellt, Text kann eingefügt und 
über das Kontextmenü formatiert werden. Im Kontextmenü des Kommentarfelds, im 
Bearbeitungsfenster über das Kontextmenü und über das Menü mit dem Pfeil ▼ unten rechts 
können dieser oder weitere Kommentare wieder gelöscht werden (Abbildung 3). 

Abbildung 3: Kommentar einer Folie
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Das Kommentarfeld kann mit Klicken und Ziehen auf der Folie platziert werden, mit einem Klick 
darauf kann der Kommentar im Bearbeitungsfenster weiter bearbeitet werden. Im Menü mit 
Ansicht > Kommentare wird die Darstellung der Kommentarfelder ein- und ausgeschaltet.

Hinweis

Der im Kommentar dargestellte Name und das Namenskürzel des Bearbeiters werden im Menü 
durch Extras > Optionen > LibreOffice > Benutzerdaten eingestellt. Verschiedenen 
Bearbeitern werden von LibreOffice unterschiedliche Hintergrundfarben für Kommentare 
zugewiesen.

Masterfolien

Eine Masterfolie wird als Vorlage für neue Folien in einem Dokument verwendet und bestimmt 
die grundlegende Darstellung der Folien, die darauf basieren. Mehrere Masterfolien können 
angelegt werden, um ein einheitliches Erscheinungsbild für die Folien eines Dokuments zu 
bestimmen, z.B. für Titel und Inhalt mit jeweils einem Hintergrund und einheitlich platzierten 
Textfeldern, Seitennummerierung, Datum oder Dateiname.

Masteransicht
Menü Ansicht > Master wechselt in die Masteransicht, dadurch wird auch die Symbolleiste der 
Masteransicht geöffnet (Abbildung 4). Diese Symbolleiste kann auch durch Ansicht > 
Symbolleisten > Masteransicht geöffnet werden. Menü Ansicht > Normal oder einem Klick auf
Masteransicht schließen in der Symbolleiste Masteransicht kehrt zurück in die Ansicht der 
Folien und schließt die Symbolleiste Masteransicht.

Abbildung 4: Dialog Masteransicht

Masterfolie erzeugen
Jede neue Zeichnung erhält eine mit Standard benannte Masterfolie. Weitere Masterfolien 
werden (nur in der Masteransicht) erzeugt

• im Menü mit Folie > Neuer Master,

• einem Klick auf Neuer Master in der Symbolleiste Masteransicht, 

• im Folienbereich über einen Rechtsklick und im Kontextmenü Auswahl Neuer Master.

Der Masterfolie kann ein Name zugewiesen werden, siehe unten “Masterfolie umbenennen”.

In die Masterfolie können alle Arten von Objekten eingefügt werden wie in eine Folie, das 
Aussehen der Folie enthält dann alle Objekte sowohl der Masterfolie als auch der Folie selbst.

Die Masterfolie einer neuen Folie wird von der bei der Erzeugung aktuellen Folie bzw. beim 
Kopieren einer Folie von dieser übernommen und kann einer Folie auch nachträglich zugewiesen
werden, siehe unten “Masterfolie zuweisen”.

Masterfolie umbenennen
Eine neue Masterfolie erhält zunächst den Namen Standard, Standard 1, Standard 2 etc. Der 
Name der Masterfolie wird (nur in der Masteransicht) geändert 

• im Menü mit Folie > Folie umbenennen,

• in der Symbolleiste Masteransicht mit einem Klick auf Master umbenennen, 
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• im Folienbereich über einen Rechtsklick und im Kontextmenü Auswahl Master 
umbenennen.

Im Dialog Masterfolie umbenennen (Abbildung 5) wird der neue Name eingetragen und mit OK 
bestätigt.

Abbildung 5: Dialog Masterfolie umbenennen

Masterfolie zuweisen
In der Normalansicht (Menü Ansicht > Normal) kann der gerade aktuellen Folie eine Masterfolie
zugewiesen werden

• im Menü mit Folie > Masterfolie,

• im Arbeitsbereich über einen Rechtsklick an einer Position, an der kein Objekt liegt, und 
im Kontextmenü Auswahl Folienmaster ändern.

Im dann folgenden Dialog Verfügbare Masterfolien (Abbildung 6) wird eine der als Folienvorlage 
bezeichnete Masterfolien gewählt.

Wird die Option Hintergrund austauschen unterhalb der Auswahlliste ausgewählt, so wird bei 
allen Folien, die den gleichen Folienmaster wie die ausgewählte haben, dieser durch den neu 
gewählten ersetzt.

Die Option Nicht verwendete Hintergründe löschen entfernt Masterfolien, die aus 
Dokumentvorlagen geladen wurden und nicht verwendet werden.

Ein ggf. in der Masterfolie definiertes Hintergrundbild ist nach dieser Zuweisung in den 
Eigenschaften der Folie (Folie > Folieneigenschaften > Hintergrund) sichtbar und kann dort 
übersteuert werden, durch wählen von Ohne wird wieder das Hintergrundbild der Masterfolie 
verwendet.
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Abbildung 6: Dialog Verfügbare Masterfolien

Masterfolie löschen
Die erste oder eine einzig verbleibende Masterfolie kann nicht gelöscht werden, nur eine von 
mehreren Masterfolien kann gelöscht werden. Nur eine Masterfolie, die keiner Folie zugewiesen 
ist, kann gelöscht werden.

Eine Masterfolie wird (nur in der Masteransicht) gelöscht 
• im Menü mit Folie > Master löschen,

• in der Symbolleiste Masteransicht mit einem Klick auf Master löschen, 

• im Folienbereich über einen Rechtsklick und im Kontextmenü Auswahl Master löschen.

Hinweis

Das Löschen einer Masterfolie geschieht ohne Rückfrage, jedoch kann die gelöschte
Folie unmittelbar danach im Menü durch Bearbeiten > Rückgängig wieder 
hergestellt werden.

Felder im Master verwenden

Feld anlegen
Ein Feld im Master wird in der Masteransicht erzeugt durch Menü Einfügen > Feldbefehl und 
die Auswahl eines der Feldtypen, damit wird ein Textfeld angelegt, in dem das gewählte Feld 
enthalten ist. Ein Feldbefehl kann auch in einem bereits vorhandenen Textfeld während des 
Bearbeitens des Textes mit Menü Einfügen > Feldbefehl eingefügt werden.

Folgende Feldtypen stehen zur Auswahl:

• Datum (fix) – das Datum zum Zeitpunkt des Einfügens, das Datum wird nicht aktualisiert

• Datum (variabel) – das Datum, wird beim Öffnen und Verlassen des Feldes aktualisiert

• Uhrzeit (fix) – die Uhrzeit zum Zeitpunkt des Einfügens, die Uhrzeit wird nicht aktualisiert

• Uhrzeit (variabel) – die Uhrzeit, wird beim Öffnen und Verlassen des Feldes aktualisiert
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• Autor – Name des Autors im Format variabel mit vollem Namen, das Format kann 
anschließend bearbeitet werden (siehe unten Feld bearbeiten), der Name des Autors 
wird in Extras > Optionen > LibreOffice > Benutzerdaten gewählt.

• Foliennummer – die Seitennummer der Folie, das Format wird im Menü Folie > 
Folieneigenschaften im Reiter Folie im Auswahlmenü unter Layout-Einstellungen 
gewählt

• Folientitel – der Name der Folie (nicht der Masterfolie), siehe oben: Folie umbenennen

• Folienanzahl – Anzahl der Folien im Dokument

• Dateiname – Name der Datei im Format mit vollem Pfadnamen, das Format kann 
anschließend bearbeitet werden (siehe unten Feld bearbeiten)

Feld bearbeiten
Nach dem Klick im Feld auf eine Position ohne Text kann der Rahmen des Feldes bearbeitet 
werden, dafür werden Ziehpunkte sichtbar.

Nach dem Klick auf eine im Feld enthaltene Textzeile kann der Text bearbeitet werden. Durch 
Rechtsklick auf ein Feld im Text wird ein Auswahlmenü für die Feldeigenschaften geöffnet 
(Beispiel Uhrzeit: Abbildung 7) . Wenn der Textcursor vor dem Feld steht oder das Feld mit 
Doppelklick markiert wurde, wird mit dem Menü Bearbeiten > Feldbefehl ein Dialog geöffnet. 
Das Auswahlmenü bzw. der Dialog sind spezifisch für den jeweiligen Feldtyp.

Abbildung 7: Auswahlmenü Feldeigenschaften Uhrzeit

Masterfolie aus Dokumentvorlagen laden
Masterfolien sind aus Vorlagen in LibreOffice verfügbar und können in eine Zeichnung geladen 
werden. Die Seitengröße einer Vorlage wird an die Zeichnung angepasst, falls sie unterschiedlich
sind, das kann dazu führen, dass Objekte gestreckt oder anders positioniert werden.

Um eine Masterfolie zu laden wird in der Masteransicht (Menü Ansicht > Master)  der Dialog 
Verfügbare Masterfolien (siehe Abbildung 6) geöffnet:

• im Menü mit Folie > Masterfolie,

• über einen Rechtsklick im Folienbereich oder im Arbeitsbereich an einer Position, an der 
kein Objekt liegt, und im Kontextmenü Auswahl Folienmaster ändern.

In diesem Dialog wird mit Laden der Dialog Masterfolie laden geöffnet (Abbildung 8), dort wird in 
einer der Kategorien eine Dokumentvorlage gewählt. Mit Vorschau kann eine Ansicht der 
ausgewählten  Dokumentvorlage aus- und eingeklappt werden. Mit OK wird die 
Dokumentvorlage in die Liste der zur Auswahl stehenden Folienvorlagen im Dialog Verfügbare 
Masterfolien übernommen. 
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Mit OK im Dialog Verfügbare Masterfolien wird die Formatvorlage der Masterfolie zugewiesen.

Die Option Hintergrund austauschen unterhalb der Auswahlliste ist hier fest ausgewählt, da bei 
allen Folien, die diese Masterfolie verwenden, diese durch die neu gewählte ersetzt wird.

Die Option Nicht verwendete Hintergründe löschen entfernt Masterfolien, die aus Dokument-
vorlagen geladen wurden und nicht verwendet werden. (Diese Operation ist erst nach Speichern 
und erneutem Öffnen des Dokuments wirksam.)

Dokumentvorlagen

Eine Dokumentvorlage ist eine Zeichnung, die als Grundlage benutzt wird, um eine andere 
Zeichnung zu erstellen. Darin können persönliche Einstellungen abgelegt werden, um sie für das 
Erstellen eines neuen Dokuments als Voreinstellung verfügbar zu machen. So kann man für 
verschiedene eigene Dokumentkategorien die passenden Einstellungen vorbereiten, damit diese 
beim Öffnen eines neuen Dokuments bereits enthalten sind.

Eine Dokumentvorlage kann zum Beispiel ein Firmenlogo, Name und weitere Informationen auf 
der Titelfolie einer Zeichnung und nur Firmenlogo und Name auf allen weiteren Folien enthalten. 
Dokumentvorlagen können alle Objekte enthalten, die auch in anderen Zeichnungen enthalten 
sind, wie z.B. Texte, Grafiken und Formatvorlagen.

Alle mit LibreOffice erstellten Dokumente basieren auf Dokumentvorlagen. Wenn keine  
Dokumentvorlage beim Erstellen eines neuen Dokuments angegeben wird, so wird die 
Standardvorlage für den jeweiligen Typ von Dokument verwendet. Die Standardvorlage 
verwendet einen fest in LibreOffice vorhandenen Umfang von Eigenschaften. Bei Bedarf kann 
die Standardvorlage geändert werden, siehe “Standard Dokumentvorlage” auf Seite 17. Mehr 
über Vorlagen und wie man Vorlagen aus anderen Quellen erhalten kann siehe im Handbuch 
Erste Schritte.

14 | Kapitel 11 Fortgeschrittene Zeichentechniken

Abbildung 8: Dialog Masterfolie laden



LibreOffice Draw enthält bei der Installation keine vorbereiteten Vorlagen, diese können jedoch 
mit den hier beschriebenen Schritten erzeugt werden. Vorlagen aus anderen Quellen können 
auch zur Benutzung in Draw installiert werden, siehe "Dokumentvorlagen importieren" auf 
Seite 21.

Dokumentvorlagen erzeugen

Als Dokumentvorlage speichern
Um eine Dokumentvorlage zu erstellen, kann man 

• eine Zeichnung als Grundlage für eine Vorlage öffnen oder eine Vorlage öffnen und 
bearbeiten,

• weitere Inhalte hinzufügen oder vorhandene Inhalte bearbeiten.

Sie wird gespeichert 

• im Menü unter Datei > Dokumentvorlagen mit Als Dokumentvorlage speichern 

• in der Standardsymbolleiste rechts neben dem Symbol Speichern auf das 
Dreieck ▼klicken und Als Dokumentvorlage speichern wählen

Im Dialog Als Dokumentvorlage speichern (Abbildung 9) wird ein Vorlagenname eingegeben und
eine Vorlagenkategorie gewählt.

Abbildung 9: Dialog Als Dokumentvorlage speichern

Falls die Vorlage als Standardvorlage in Draw verwendet werden soll, wird das Kontrollkästchen 
Dokumentvorlage als Standard setzen gewählt. Mit OK wird die Vorlage gespeichert.

Speichern unter
Im Menü Datei > Speichern unter kann eine Dokumentvorlage ebenfalls gespeichert werden. 
Dort wird der Name der Vorlage angegeben, als Pfad wird der Vorlagenordner von LibreOffice 
angegeben und im Auswahlmenü unten rechts das Format ODF-Zeichnungsvorlage (Open 
Document Format, .otg) ausgewählt. Mit Speichern wird die Vorlage erstellt. Dabei wird die 
Dokumentvorlage jedoch nicht vom Vorlagenmanagement von LibreOffice erfasst.

Der Vorlagenordner hängt vom Betriebssystem und den Einstellungen ab, siehe unten
Dokumentvorlagen verwalten.
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Hinweis

Damit LibreOffice die gespeicherte Datei als Vorlage erkennt, muss sie im 
LibreOffice Vorlagenordner abgelegt werden.

Zeichnung aus einer Dokumentvorlage erzeugen
Anstelle der Standardvorlage kann eine neue Zeichnung mit einer anderen Vorlage erzeugt 
werden.

Start Center
Im Start Center, wenn LibreOffice gestartet wurde und kein Dokument geöffnet ist, kann eine 
Zeichnung mit einer hier gewählten Vorlage erzeugt werden:

• Klicken auf Dokumentvorlagen, um die verfügbaren Vorlagen für alle Dokumenttypen 
anzuzeigen, dann Klick auf die gewünschte Vorlage.

• Klicken auf das Dreieck ▼ rechts von Dokumentvorlagen und im Auswahlmenü Draw 
Dokumentvorlagen wählen, um die für Zeichnungen verfügbaren Vorlagen anzuzeigen, 
dann Klick auf die gewünschte Vorlage.

Ein neues Dokument basierend auf der gewählten Vorlage wird geöffnet. 

Der Dialog Dokumentvorlagen über die Menüpunkte Datei > Neu > Dokumentvorlagen und 
Datei > Dokumentvorlagen > Dokumentvorlagen verwalten und das Tastenkürzel (s.u.) sind 
im Start Center ebenfalls verfügbar.

Dialog Dokumentvorlagen
Wenn Draw bereits geöffnet ist, erzeugt Draw eine neue Zeichnung mit gewählter anstelle der 
Standarddokumentvorlage 

• im Menü Datei > Neu > Dokumentvorlagen 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten

• mit dem Tastenkürzel Strg+Umschalt+N .

Im darauf geöffneten Dialog (Abbildung 10) ist in Filter bereits Zeichnungen ausgewählt. Die 
gewünschte Vorlage wird ausgewählt und mit Öffnen das neue Dokument erzeugt oder mit 
Doppelklick darauf das neue Dokument direkt erzeugt. Das Dokument ist damit noch nicht 
gespeichert, dazu muss z.B. Menü Datei > Speichern gewählt werden.
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Abbildung 10:  Dialog Dokumentvorlagen

Standard Dokumentvorlage
Ein neues Dokument, das angelegt wird, ohne eine Dokumentvorlage zu wählen, verwendet die 
in LibreOffice fest verfügbaren Einstellungen. Es kann aber jede Zeichnungsvorlage als  
Standardvorlage festgelegt werden, wenn sie im LibreOffice Vorlagenordner abgelegt wird.

Standard Dokumentvorlage festlegen
Die Standardvorlage wird eingestellt

• im Menü Datei > Neu > Dokumentvorlagen, 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten, 

• mit dem Tastenkürzel Strg+Umschalt+N .

Im damit geöffneten Dialog Dokumentvorlagen (Abbildung 10) wird die Auswahl Filter auf 
Zeichnungen eingestellt, die als Standard festzulegende Vorlage mit einfachem Klick angewählt 
und mit der rechten Maustaste im Kontextmenü Als Standard festlegen gewählt. Es wird keine 
Rückmeldung über diese Änderung gegeben, die Vorlage ist in dieser Ansicht jedoch nun in der 
linken oberen Ecke über ein mit grünem Häkchen  versehenen Dokumentsymbol markiert. 
Der Dialog wird mit Schließen beendet.

Die nächste Zeichnung, die mit Draw neu angelegt wird, verwendet die vorher gewählte Vorlage 
als Standard.

Hinweis

Wenn eine Zeichnung als Standardvorlage verwendet werden soll, muss sie 
zunächst als Vorlage gespeichert werden, siehe “Dokumentvorlagen erzeugen” auf 
Seite 15. Erst danach kann diese Vorlage als Standard festgelegt werden.
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Standard Dokumentvorlage zurücksetzen
Die in Draw für neue Dokumente als Standard verwendete Vorlage kann auf den ursprünglichen 
Zustand zurückgesetzt werden

• im Menü Datei > Neu > Dokumentvorlagen, 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten, 

• mit dem Tastenkürzel Strg+Umschalt+N .

Im damit geöffneten Dialog Dokumentvorlagen (Abbildung 10) wird die Auswahl Filter auf 
Zeichnungen eingestellt, die als Standard festgelegte Vorlage ist in dieser Ansicht an einem mit 
grünem Häkchen  versehenen Dokumentsymbol in der linken oberen Ecke erkennbar. Sie 
wird mit einfachem Klick angewählt und mit der rechten Maustaste im Kontextmenü Auf 
Standard zurücksetzen gewählt. Es wird keine Rückmeldung über diese Änderung gegeben, 
die Vorlage ist nun jedoch nicht mehr mit dem grünem Häkchen in der linken oberen Ecke 
markiert. Der Dialog wird mit Schließen beendet.

Die nächste Zeichnung, die mit Draw neu angelegt wird, verwendet wieder die in LibreOffice fest 
verfügbaren Einstellungen als Standard.

Dokumentvorlagen bearbeiten
Dokumentvorlagen können bearbeitet werden und auf Zeichnungen angewendet werden, die 
mithilfe dieser Vorlage erstellt wurden. Inhalte in der Zeichnung, die nicht in der Vorlage enthalten
sind, können nicht damit verändert werden.

Hinweis

Dokumentvorlagen, die in LibreOffice enthalten sind, können nicht bearbeitet oder 
gelöscht werden. Nur Dokumentvorlagen, die mit LibreOffice erzeugt oder importiert 
wurden, können bearbeitet oder gelöscht werden.

Zum Bearbeiten wird ein Dialog geöffnet 

• im Menü Datei > Neu > Dokumentvorlagen, 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten, 

• mit dem Tastenkürzel Strg+Umschalt+N .

Im Dialog Dokumentvorlagen (Abbildung 10) wird die zu bearbeitende Vorlage ausgewählt und 
mit der rechten Maustaste im Kontextmenü Bearbeiten gewählt. (Mit Öffnen wird nicht die 
Vorlage geöffnet sondern ein neues Dokument geöffnet, das diese Vorlage benutzt.)

Nach dem Bearbeiten wird die Vorlage im Menü mit Datei > Speichern bzw. Datei > 
Speichern unter oder dem Tastaturkürzel Strg +S  gespeichert oder im Menü unter Datei > 
Dokumentvorlagen mit Als Dokumentvorlage speichern, siehe auch “Dokumentvorlagen 
erzeugen” auf Seite 15. Für die Dateinamenserweiterung wird dabei 
ODF-Zeichnungsvorlage (.otg) anstelle .odg gewählt.

Hinweis

Eine Vorlage, die Teil von LibreOffice ist, kann nicht bearbeitet werden, beim Öffnen 
dieser Vorlage erscheint eine Meldung, dass das Dokument schreibgeschützt ist. Mit
einem Klick auf Bearbeiten kann eine Kopie der Vorlage geöffnet werden, die nach 
der Bearbeitung im Menü mit Datei > Speichern unter gespeichert wird.
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Geänderte Dokumentvorlage auf eine Zeichnung anwenden
Nachdem die von einer Zeichnung verwendete Dokumentvorlage verändert wurde, erscheint 
beim Öffnen der Zeichnung ein Dialog (Abbildung 11), in dem gewählt werden kann, ob die 
geänderten Einstellungen aus der Dokumentvorlage in die Zeichnung übernommen werden 
sollen.

Abbildung 11:  Dialog Vorlagen übernehmen

• Mit Vorlagen übernehmen werden die Änderungen aus der Vorlage in die Zeichnung 
übernommen, 

• mit Vorlagen beibehalten bleiben die Einstellungen in der Zeichnung unverändert und 
der Dialog erscheint nicht wieder beim Öffnen der Zeichnung.

Hinweis

Wenn Vorlagen beibehalten gewählt wurde, ist die Zeichnung nicht mehr mit der 
Dokumentvorlage verbunden und erscheint auch nicht mehr unter Datei > 
Eigenschaften > Allgemein. Um die Zeichnung wieder mit der Vorlage zu 
verbinden, muss sie erneut zugewiesen werden, siehe unten “Einer Zeichnung 
zugewiesene Dokumentvorlage ändern”.

Einer Zeichnung zugewiesene Dokumentvorlage ändern
Um eine bestehende Zeichnung mit einer anderen Dokumentvorlage zu verknüpfen, stehen 
diese Möglichkeiten zur Verfügung:

• Erzeugen Sie ein neues Dokument, das die gewünschte Dokumentvorlage verwendet, 
und kopieren Sie den Inhalt der vorherigen Zeichnung in das neue Dokument.

• Erweitern Sie LibreOffice mit einer Extension, die unter 
https://de.libreoffice.org/discover/templates-and-extensions/ angeboten wird. Unter 
https://extensions.libreoffice.org/en/extensions/show/template-changer (auf Englisch) 
kann die Template Changer extension heruntergeladen und im Menü unter Extras > 
Extension-Manager in LibreOffice installiert werden (mit Hinzufügen die 
heruntergeladene .oxt Datei auswählen). Starten Sie LibreOffice neu, um die 
Erweiterung zu aktivieren. Unter Datei > Dokumentvorlagen sind nun die neuen 
Menüpunkte Dokumentvorlage ändern (aktives Dokument) und Dokumentvorlage 
ändern (Verzeichnis) verfügbar.

Dokumentvorlagen verwalten
LibreOffice kann Vorlagen nur finden, wenn sie in LibreOffice Vorlagenordnern liegen 
(Kategorien). Neue LibreOffice Vorlagenkategorien können angelegt und benutzt werden, um 
Vorlagen zu verwalten. Es können z.B. Kategorien für unterschiedliche Projekte oder 
verschiedene Kunden angelegt werden. Vorlagen können auch in diese Kategorien hinein 
importiert oder exportiert werden. 

Dokumentvorlagen | 19

https://extensions.libreoffice.org/en/extensions/show/template-changer
https://de.libreoffice.org/discover/templates-and-extensions/


Tipp

Der Dateipfad der LibreOffice Vorlagenkategorien hängt vom Betriebssystem ab. Im 
Menü unter Extras > Optionen > LibreOffice > Pfade werden die Pfade 
(Benutzerpfade und in einer Spalte weiter rechts Interne Pfade) angezeigt. Die 
Benutzerpfade können mit Bearbeiten, Standard und Zurücksetzen geändert 
werden.

Kategorien für Dokumentvorlagen erzeugen
Eine neue Kategorie für die Dokumentvorlagen wird erstellt 

• im Menü Datei > Neu > Dokumentvorlagen 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten

• mit dem Tastenkürzel Strg+Umschalt+N .

Im darauf geöffneten Dialog (Abbildung 10) wird in Filter Zeichnungen ausgewählt, in der 
Auswahlliste Verwalten wird Neue Kategorie gewählt. Nach Eingabe des gewünschten Namens
wird mit OK bestätigt.

Kategorien für Dokumentvorlagen umbenennen
Eine selbst angelegte Kategorie für die Dokumentvorlagen (nicht die von LibreOffice 
voreingestellten) kann umbenannt werden 

• im Menü Datei > Neu > Dokumentvorlagen 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten

• mit dem Tastenkürzel Strg+Umschalt+N .

Im darauf geöffneten Dialog (Abbildung 10) wird in Filter Zeichnungen selektiert.

In der Auswahlliste rechts davon wird die betreffende Kategorie gewählt. In der Auswahlliste 
Verwalten kann nun Kategorie umbenennen gewählt werden. Nach Eingabe des gewünschten 
Namens wird mit OK bestätigt.

Hinweis

Für die von LibreOffice voreingestellten Kategorien ist in der Auswahlliste Verwalten 
die Auswahl Kategorie umbenennen ausgegraut und kann nicht gewählt werden.

Kategorien für Dokumentvorlagen löschen
Eine selbst angelegte Kategorie für die Dokumentvorlagen (nicht die von LibreOffice 
voreingestellten) kann gelöscht werden 

• im Menü Datei > Neu > Dokumentvorlagen 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten

• mit dem Tastenkürzel Strg+Umschalt+N .

Im darauf geöffneten Dialog (Abbildung 10) wird in Filter Zeichnungen selektiert.

In der Auswahlliste rechts davon wird die zu löschende Kategorie gewählt. In der Auswahlliste 
Verwalten kann nun Kategorie löschen gewählt werden. In einem Abfragedialog wird mit OK 
bestätigt.
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Vorsicht

Der Ordner, der im Dateisystem die zu löschende Kategorie repräsentiert, wird 
einschließlich aller darin enthaltenen Vorlagen gelöscht. Die Vorlagen können nicht 
mit dem Befehl Rückgängig wiederhergestellt werden!

Hinweis

Für die von LibreOffice voreingestellten Kategorien ist in der Auswahlliste Verwalten 
die Auswahl Kategorie löschen ausgegraut und kann nicht gewählt werden.

Dokumentvorlagen verschieben
Eine selbst angelegte Dokumentvorlage (nicht die von LibreOffice vorinstallierten) kann in eine 
andere Kategorie verschoben werden 

• im Menü Datei > Neu > Dokumentvorlagen 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten

• mit dem Tastenkürzel Strg+Umschalt+N .

Im Dialog Dokumentvorlagen (Abbildung 10) wird in der Auswahlliste die Kategorie gewählt, in 
der sich die betreffende Vorlage befindet, und diese angeklickt. Mit der rechten Maustaste wird 
das Kontextmenü aufgerufen und Verschieben gewählt. Im darauf folgenden Dialog 
(Abbildung 12) wird die Kategorie ausgewählt, in die die Dokumentvorlage verschoben werden 
soll oder der Name einer neuen Kategorie angegeben, die damit in einem Zug angelegt und in 
die die gewählte Dokumentvorlage verschoben wird.

Abbildung 12: Dialog Vorlage verschieben

Dokumentvorlagen importieren
Dokumentvorlagen können aus verschiedenen Quellen heruntergeladen werden, auch mithilfe 
des Extension Managers aus dem offiziellen LibreOffice Extension-Archiv. Eine heruntergeladene
Vorlage wird an beliebiger Stelle im Dateisystem gespeichert, dann 

• im Menü Datei > Neu > Dokumentvorlagen 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten

• mit dem Tastenkürzel Strg+Umschalt+N .

Im darauf geöffneten Dialog (Abbildung 10) wird in Filter Zeichnungen ausgewählt.
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In der Auswahlliste rechts davon wird die Kategorie gewählt, in der die importierte Vorlage 
abgelegt werden soll. In der Auswahlliste Verwalten kann nun Importieren gewählt werden. In 
einem Dateidialog wird die heruntergeladene Datei gewählt und mit Öffnen bestätigt.

Hinweis

Extensions (siehe https://de.libreoffice.org/discover/templates-and-extensions/) 
können mit dem Extension Manager im Menü unter Extras > Extension-Manager 
verwaltet werden, dieser ist im Handbuch Erste Schritte Kapitel 14 LibreOffice 
Anpassen beschrieben.

Dokumentvorlagen exportieren
Die eigenen Dokumentvorlagen können auch exportiert und damit an andere Anwender 
weitergegeben werden:

• im Menü Datei > Neu > Dokumentvorlagen 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten

• mit dem Tastenkürzel Strg+Umschalt+N .

Im Dialog Dokumentvorlagen (Abbildung 10) wird die zu exportierende Vorlage ausgewählt und 
mit der rechten Maustaste im Kontextmenü Exportieren gewählt. In einem Dateidialog wird der 
Pfad gewählt, unter dem die Datei abgelegt werden soll, und mit OK bestätigt.

Hinweis

Exportieren löscht die Vorlage nicht aus den verfügbaren Vorlagen, es wird eine 
Kopie der Vorlage im Dateisystem abgelegt.

Dokumentvorlagen löschen
Die eigenen Dokumentvorlagen können gelöscht werden 

• im Menü Datei > Neu > Dokumentvorlagen 

• im Menü Datei > Dokumentvorlagen > Dokumentvorlagen verwalten

• mit dem Tastenkürzel Strg+Umschalt+N .

Im Dialog Dokumentvorlagen (Abbildung 10) wird die zu löschende Vorlage ausgewählt und mit 
der rechten Maustaste im Kontextmenü Löschen gewählt. In einem Bestätigungsdialog wird mit 
OK bestätigt.

Vorsicht

Die Dokumentvorlage wird nach der Abfrage endgültig gelöscht und kann nicht mit 
dem Befehl Rückgängig wiederhergestellt werden!

Tipp

Im Dialog Dokumentvorlagen kann die selektierte Vorlage auch mit der Taste Entf  
gelöscht werden.

Hinweis

Dokumentvorlagen, die in LibreOffice enthalten sind, können nicht gelöscht werden. 
Nur Dokumentvorlagen, die mit LibreOffice erzeugt oder importiert wurden, können 
gelöscht werden.
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Dokumentvorlage als Datei
Dokumentvorlagen können als Datei erzeugt und an beliebigen Orten im Dateisystem eines 
Rechners gespeichert werden, ohne dass der Dialog Dokumentvorlagen dafür benötigt wird. 
Einige Unterschiede sind dazu jedoch zu beachten.

Zeichnung aus einer Dokumentvorlage
Eine Zeichnung basierend auf einer Dokumentvorlage wird auch mit einem Doppelklick in einem 
Dateibrowser auf die Vorlage erzeugt. Die auf diesem Weg erzeugte Zeichnung ist jedoch nicht 
mit dieser Vorlage verknüpft. Die Vorlage wird nicht in den Eigenschaften der Zeichnung 
aufgeführt und Änderungen an der Vorlage können nicht direkt auf die Zeichnung angewendet 
werden. Für viele Bedürfnisse kann dies trotzdem ausreichend sein. 

Dokumentvorlage aus einer Zeichnung
Eine Dokumentvorlage kann aus einer Zeichnung im Menü mit Datei > Speichern unter und 
Auswahl von ODF-Zeichnungsvorlage (Open Document Format, .otg) erzeugt und an beliebiger 
Stelle im Dateisystem abgelegt werden, z.B. in einem Projektordner. 

Die so erzeugte Vorlage ist im Dialog Dokumentvorlagen erreichbar, wenn der entsprechende 
Dateiordner zu den Dokumentvorlagen in Extras > Optionen > LibreOffice > Pfade zugefügt 
wurde, siehe “Dokumentvorlagen verwalten” auf Seite 19 und “Dokumentvorlagen importieren” 
auf Seite 21.

Ansicht in mehreren Fenstern

In LibreOffice Draw können von einer einzigen Zeichnung mehrere Ansichten gleichzeitig 
geöffnet werden. Diese Ansichten werden in mehreren Fenstern des Betriebssystems angezeigt 
und können unterschiedliche Einstellungen für die Ebenen (Layout, Steuerelemente, Maßlinien), 
verschiedenen Maßstab und Ursprungspunkt und verschiedene Seiten der Zeichnung und auch 
Masteransicht und Normalansicht zur gleichen Zeit verwenden. 

Eine weitere Ansicht wird geöffnet mit Menü Fenster > Neues Fenster. Die Fenster können 
entsprechend den Möglichkeiten des Betriebssystems angeordnet werden. In jedem Fenster 
kann diese eine Zeichnung gleichzeitig bearbeitet werden. Eine Änderung in einem der Fenster 
wirkt sich direkt auf die Darstellung in anderen Fenstern aus. 

Jedes Fenster wird von Draw mit einer Nummer versehen, die Nummer ist sowohl in der 
Titelleiste des Fensters als auch im Menü Fenster zu sehen, siehe ein Beispiel in Abbildung 13. 
Wenn weitere Dokumente in LibreOffice geöffnet sind, werden alle Fenster aller geöffneten 
Dokumente in der Liste im Menü Fenster aufgeführt, das aktive Fenster ist hier durch einen 
Punkt im Kreis markiert. Das aktive Fenster kann gewechselt werden durch Klicken auf das 
gewünschte Fenster in der Liste oder durch Klicken auf das Fenster selbst. 

Ein Fenster kann im Menü mit Fenster > Fenster schließen oder mit dem Tastenkürzel Strg +W
oder durch das Schließen des Fensters in der Titelleiste geschlossen werden. Im Menü Datei > 
Schließen schließt alle Fenster zu dieser Zeichnung.
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Abbildung 13: Beispiel mehrerer Fenster

Ebenen

Mit Ebenen in Draw können Objekte einer Zeichnung gruppiert werden. Ebenen sind wie 
separate Arbeitsbereiche, für die die Sichtbarkeit, das Drucken oder das Bearbeiten gesperrt und
freigegeben werden kann. 

Durch Zuordnung zu einer Ebene wird für die Objekte keine Anordnung festgelegt, lediglich die 
Ebene Steuerelemente ist immer im Vordergrund. Die Anordnung der Objekte einer Zeichnung 
ergibt sich aus der Reihenfolge, in der sie hinzugefügt werden. Diese Anordnung kann im Menü 
mit Form > Anordnung und im Kontextmenü eines Objekts geändert werden. 

Sowohl in den Folien der Normalansicht als auch in den Masterfolien können Objekte einer 
Ebene hinzugefügt werden. 

Die in einer Zeichnung enthaltenen Ebenen werden durch Reiter am unteren Rand des 
Arbeitsbereichs angezeigt. Durch Klicken auf einen Reiter wird die Ebene ausgewählt, siehe  
Abbildung 14, in der die Ebene Layout ausgewählt ist.

Abbildung 14: Reiter Ebenen im Arbeitsbereich

 Hinweis

Eine neu hinzugefügte Ebene wird zu allen Folien und auch zu den Masterfolien der 
Zeichnung hinzugefügt. Ein neu erzeugtes Objekt wird auf der aktuellen Folie oder 
Masterfolie in der aktuell ausgewählten Ebene angelegt.

Tipp

Ein Objekt, das auf allen Folien einer Zeichnung erscheinen soll (z.B. ein Firmen-
logo), sollte auf der entsprechenden Masterfolie angelegt werden, siehe oben
Masterfolien.

Standard Ebene

Normalansicht
In der Normalansicht sind in LibreOffice Draw drei Ebenen voreingestellt, diese drei Ebenen 
können nicht gelöscht oder umbenannt werden:
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• Layout – Dies ist der Standardarbeitsbereich, in den Objekte normalerweise eingefügt 
werden.

• Steuerelemente – Diese Ebene enthält Steuerelemente, denen eine Funktion 
zugeordnet wurde. Objekte auf dieser Ebene liegen immer vor den Objekten anderer 
Ebenen. 

• Maßlinien – In dieser Ebene werden die Maßlinien abgelegt.

Masteransicht
In der Masteransicht ist eine einzige Ebene Hintergrundobjekte voreingestellt, es gibt keine 
Ebenen für Steuerelemente oder Maßlinien.

Hinweis

Nur Ebenen, die zu einem Zeichnungsdokument hinzugefügt wurden, können 
umbenannt oder gelöscht werden. Die Standardebenen Layout, Steuerelemente, 
Maßlinien und Hintergrundobjekte können nicht umbenannt oder gelöscht werden.
Es können jedoch der Titel und die Beschreibung sowie die Einstellungen Sichtbar, 
Druckbar und Gesperrt für die Ebene geändert werden.

Ebenen einfügen
In der Normalansicht und auch in der Masteransicht kann eine Ebene hinzugefügt werden:

• im Menü Einfügen > Ebene

• im Kontextmenü über den Reitern Ebene und Ebene einfügen

• mit Doppelklick auf den leeren Bereich rechts der Reiter Ebene 

Im Dialog Ebene einfügen (siehe Abbildung 15) kann ein Name, ein Titel und eine Beschreibung 
für die neue Ebene gewählt werden. 

Abbildung 15: Dialog Ebene einfügen

In der Voreinstellung ist die neue Ebene sichtbar und druckbar und nicht gesperrt. Mit den 
Kontrollkästchen kann dies für die Ebene gewählt werden: 
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• Sichtbar – Wenn dies ausgeschaltet ist, werden die darin enthaltenen Objekte beim 
Bearbeiten der Zeichnung nicht angezeigt und der Name der Ebene ist im Reiter blau 
dargestellt.

• Druckbar – Wenn dies ausgeschaltet ist, wird die Ebene nicht gedruckt und der Name 
der Ebene ist im Reiter unterstrichen dargestellt. Zum Beispiel können so Anleitungen 
und Notizen im Dokument abgelegt, in der Bearbeitungsphase auch gedruckt aber im 
endgültigen Stand verborgen werden.

• Gesperrt – Mit dieser Einstellung werden alle darin enthaltenen Objekte vor Verändern, 
Verschieben und Löschen geschützt und es können keine weiteren Objekte zugefügt 
werden. Der Name der Ebene ist im Reiter dann kursiv dargestellt.

Ebenen ändern
Die beim Einfügen einer Ebene gewählten Einstellungen können geändert werden:

• wenn die Ebene selektiert ist im Menü Format > Ebene

• im Kontextmenü über dem betreffenden Reiter Ebene und Ebene ändern

• mit Doppelklick auf den betreffenden Reiter Ebene 

Der Dialog Ebene ändern entspricht dem Dialog Ebene einfügen (siehe Abbildung 15). Es kann 
der Name, der Titel und die Beschreibung sowie die Einstellungen Sichtbar, Druckbar und 
Gesperrt für die Ebene geändert und mit OK bestätigt werden.

Ebene auswählen
Mit einem Klick auf den Reiter Ebene wird die Ebene ausgewählt. Wenn es mehr Ebenen gibt als
Reiter auf der Breite des Fensters dargestellt werden können, sind die Navigationsfelder links der
Reiter aktiv, um die Liste der Reiter ganz nach links, weiter nach links, weiter nach rechts oder 
ganz nach rechts zu verschieben.

Objekte, die der Zeichnung zugefügt werden, werden in genau die Ebenen eingefügt, die beim 
Hinzufügen ausgewählt ist. Steuerelemente werden dabei immer der Ebene Steuerelemente und
Maßlinien immer der Ebene Maßlinien zugefügt.

Ebenen verbergen
Eine Ebene kann verborgen werden:

• wenn die Ebene selektiert ist im Menü Format > Ebene

• im Kontextmenü über dem betreffenden Reiter Ebene und Ebene ändern

• mit Doppelklick auf den betreffenden Reiter Ebene 

Im Dialog Ebene ändern (siehe Abbildung 15) das Häkchen am Kontrollkästchen Sichtbar 
entfernen und mit OK bestätigen. 

• Alternativ kann Sichtbar direkt mit Umschalt + Klick auf den Reiter Ebene geändert 
werden.

Die darin enthaltenen Objekte werden dadurch beim Bearbeiten der Zeichnung nicht angezeigt 
und der Name der Ebene ist im Reiter blau dargestellt.

Verborgene Ebenen anzeigen
Eine verborgene Ebene kann wieder sichtbar gemacht werden:

• wenn die Ebene selektiert ist im Menü Format > Ebene

• im Kontextmenü über dem betreffenden Reiter Ebene und Ebene ändern

• mit Doppelklick auf den betreffenden Reiter Ebene 
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Im Dialog Ebene ändern (siehe Abbildung 15) das Häkchen am Kontrollkästchen Sichtbar 
setzen und mit OK bestätigen. 

• Alternativ kann Sichtbar direkt mit Umschalt  + Klick auf den Reiter Ebene geändert 
werden.

Die darin enthaltenen Objekte werden dadurch beim Bearbeiten der Zeichnung wieder angezeigt 
und der Name der Ebene ist im Reiter nicht mehr blau dargestellt.

Ebenen sperren
Eine Ebene kann gesperrt werden:

• wenn die Ebene selektiert ist im Menü Format > Ebene

• im Kontextmenü über dem betreffenden Reiter Ebene und Ebene ändern

• mit Doppelklick auf den betreffenden Reiter Ebene 

Im Dialog Ebene ändern (siehe Abbildung 15) das Häkchen am Kontrollkästchen Gesperrt 
setzen und mit OK bestätigen. 

• Alternativ kann Gesperrt direkt mit Strg  + Klick auf den Reiter Ebene geändert werden.

Die darin enthaltenen Objekte werden vor Verändern, Verschieben und Löschen geschützt und 
es können keine weiteren Objekte zugefügt werden. Der Name der Ebene ist im Reiter dann 
kursiv dargestellt.

Ebenen freigeben
Eine Ebene kann wieder freigegeben werden:

• wenn die Ebene selektiert ist im Menü Format > Ebene

• im Kontextmenü über dem betreffenden Reiter Ebene und Ebene ändern

• mit Doppelklick auf den betreffenden Reiter Ebene 

Im Dialog Ebene ändern (siehe Abbildung 15) das Häkchen am Kontrollkästchen Gesperrt 
entfernen und mit OK bestätigen. 

• Alternativ kann Gesperrt direkt mit Strg  + Klick auf den Reiter Ebene geändert werden.

Die darin enthaltenen Objekte werden nicht mehr vor Verändern, Verschieben und Löschen 
geschützt und es können wieder Objekte zugefügt werden. Der Name der Ebene ist im Reiter 
dann nicht mehr kursiv dargestellt.

Ebenen umbenennen
Die Benennungen einer Ebene können geändert werden:

• wenn die Ebene selektiert ist im Menü Format > Ebene

• im Kontextmenü über dem betreffenden Reiter Ebene und Ebene ändern

• mit Doppelklick auf den betreffenden Reiter Ebene 

Der Dialog Ebene ändern entspricht dem Dialog Ebene einfügen (siehe Abbildung 15). Es kann 
der Name, der Titel und die Beschreibung für die Ebene geändert und mit OK bestätigt werden.

Alternativ kann 

• im Kontextmenü über dem betreffenden Reiter Ebene und Auswahl von Ebene 
umbenennen 

• mit Alt  + Klick  auf den Reiter Ebene
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ein Eingabefeld geöffnet, ein neuer Name eingegeben und mit der Eingabetaste oder einem Klick
außerhalb des Feldes bestätigt (oder mit der Taste Esc  abgebrochen) werden.

Ebenen löschen
Eine Ebene kann gelöscht werden:

• im Kontextmenü über dem betreffenden Reiter Ebene und Ebene löschen

In einem Abfragedialog wird mit OK bestätigt. Die Ebenen und alle Objekte auf dieser Ebenen 
werden gelöscht. 

Die gelöschte Ebene kann unmittelbar danach im Menü durch Bearbeiten > Rückgängig wieder
hergestellt werden.

Objekte zwischen Ebenen verschieben
Ein oder mehrere Objekte zugleich, die von einer Ebene in eine andere verschoben werden 
sollen, werden ausgewählt. Dies kann durch Lasso (ziehen mit der Maus und gewünschte 
Objekte mit dem Rechteck umfassen) und nach und nach mit Umschalt+Klick geschehen. Wenn 
das Draw-Fenster breit genug dafür ist, dann wird die Anzahl der ausgewählten Objekte in der 
Statusleiste angezeigt. 

Die Objekte werden verschoben 

• im Menü mit Bearbeiten > Ausschneiden oder Strg  + X , in der Ebenenleiste den 
Reiter der gewünschten Zielebene wählen und im Menü mit Bearbeiten > Einfügen 
oder Strg  + V , 

• durch Klicken und Ziehen der ausgewählten Objekte und loslassen auf dem Reiter der 
gewünschten Ebene. 

Die Objekte werden in der neuen Ebene an genau an der Stelle eingefügt, an der sie in der 
Ebene zuvor positioniert waren. 

Koordinatensystem

X- und Y-Achsen
Die X-Achse misst die horizontale Position eines Objektes von links, die Y-Achse misst die 
vertikale Position eines Objektes von oben bezogen auf die linke obere Ecke des Druckbereichs. 

Links und oberhalb des Arbeitsbereichs zeigen Lineale die Koordinaten an (negative Positionen 
ohne Vorzeichen). Die Lineale können über Ansicht > Lineale ein- und ausgeschaltet werden. 
Im Kontextmenü über den Linealen kann die Maßeinheit der Lineale (metrische, nicht-metrische 
und drucktechnische) gewählt werden. 

In der Statusleiste wird die exakte Mausposition angezeigt. Die hier verwendete Einheit wird 
unabhängig von den Linealen im Menü mit Extras > Optionen > LibreOffice Draw > Allgemein 
gewählt.

Wenn ein Objekt ausgewählt ist, zeigen Markierungen in den Linealen die Abmessungen des 
Objekts an, an diesen Markierungen in den Linealen kann die Größe des Objekts durch Ziehen 
mit der Maus verändert werden. 

Die Maße eines Objekts, die im Dialog Position und Größe (im Menü Format > Position und 
Größe und im Kontextmenü unter Position und Größe) angegeben werden, beziehen sich auf 
dieses Koordinatensystem. 
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Arbeitsbereich
Der Arbeitsbereich in LibreOffice Draw enthält neben dem Papier- und Druckbereich einen 
äußeren Bereich, der jeweils links und rechts eine Seitenbreite und oben und unten eine halbe 
Seitenhöhe umfasst. In den Linealen ist dieser Bereich umrahmt dargestellt. 

Objekte können innerhalb und auch außerhalb der Seite platziert und im Dokument gespeichert 
werden. Objekte bzw. Anteile von Objekten außerhalb davon werden beim Drucken und 
Exportieren nicht berücksichtigt. Der äußere Bereich kann damit für Objekte in der 
Entwurfsphase benutzt werden.

Die Zeichenblattgröße kann maximal 600 cm x 600 cm betragen.

Objektposition
Der Ursprungspunkt des Koordinatensystems (X=0, Y=0) ist in der Voreinstellung die linke obere 
Ecke des Zeichnungsbereichs ohne Rand. Der Ursprungspunkt kann verschoben werden, indem 
der Schnittpunkt der beiden Lineale mit der Maus angeklickt und an die neue Position gezogen 
wird, während des Ziehens werden Hilfslinien angezeigt. Fangen am Raster, Rändern und 
Objekten wird berücksichtigt soweit dies eingestellt ist (Menü  Extras > Optionen > LibreOffice 
Draw > Raster. 

Das Verschieben des Ursprungs wird nur für die aktuelle Ansicht verwendet und wird nicht im 
Dokument gespeichert. Der Ursprungspunkt kann mit einem Doppelklick auf den Schnittpunkt 
der beiden Lineale auf seine Voreinstellung zurückgesetzt werden.

Genauigkeit
Draw benutzt intern Integer-Zahlenwerte für 1/100 mm. Daher ist es z.B. nicht möglich, eine 
exakte Position für ⅛ Zoll einzustellen (für ¼ Zoll jedoch schon). Viele Dialogfelder sind zudem 
auf zwei Dezimalstellen begrenzt. 

Die höchste Genauigkeit wird erreicht, indem im Menü unter (Menü  Extras > Optionen > 
LibreOffice Draw > Allgemein die Maßeinheit auf Millimeter eingestellt wird. Die Lineale zeigen
nun metrische Einheiten. Eine andere Einheit für die Lineale wird mit einem Rechtsklick im 
Kontextmenü ausgewählt, die horizontalen und vertikalen Lineale können auf unterschiedliche 
Einheiten eingestellt werden. 

Zeichnungsmaßstab

In Draw ist die Zeichenfläche voreingestellt auf die Seitengröße A4 oder Letter, je nach 
Einstellung im Betriebssystem und dem am Rechner angeschlossenen Standarddrucker. Es 
kann jedoch je nach Größe der Objekte hilfreich sein, die Objekte in der Zeichnung größer oder 
kleiner darzustellen, z.B. auf 1:10 oder 2:1.

Der Zeichnungsmaßstab wird im Menü unter Extras > Optionen > LibreOffice Draw > 
Allgemein eingestellt. Unter Skalierung kann der Zeichnungsmaßstab in einem Auswahlmenü 
eingestellt werden. Die Voreinstellung für den Maßstab ist 1:1. Eine Änderung des Maßstabs 
zeigt sich auch in der Skala der horizontalen und vertikalen Lineale. 

Änderungen des  Zeichnungsmaßstabs ändern nichts am Zeichnen. Draw errechnet die 
passenden Zahlenwerte, z.B. in der Bemaßung. Der Abstand der Rasterpunkte ist unabhängig 
vom  Zeichnungsmaßstab, da das Raster lediglich eine sichtbare Zeichenhilfe ist und kein 
Zeichnungsobjekt.

Mit einem kleineren Maßstab wie z.B. 1:4 lassen sich Objekte zeichnen, die nicht auf die 
Papierfläche passen würden. Mit einem größeren Maßstab wie z.B. 4:1 können kleine Objekte 
mit besserer Genauigkeit gezeichnet und detaillierter betrachtet werden. Ein Beispiel für die 
Wirkung des Maßstabs ist in Abbildung 16 zu sehen, in der ein Rechteck mit Bemaßung bei 
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verschiedenen Maßstäben unterschiedlich groß ist, aber auf der Zeichenfläche gleich groß 
erscheint, die Bemaßung wird von Draw entsprechend verändert. 

Abbildung 16: Beispiel Maßstab einer Zeichnung

Bemaßung

In Draw können Objekte bemaßt werden, sodass die Zeichnung damit einer technischen 
Zeichnung entspricht. Die Maßlinien können oben oder unten bzw. links oder rechts von 
Objekten platziert werden. 

Die erzeugten Bemaßungen werden von Draw in die Ebene Maßlinien gelegt. 

Das Beispiel einer Maßlinie und seine Hilfslinien zeigt Abbildung 17. 

Wenn die Einstellung Linke bzw. Rechte Hilfslinie (siehe Maßlinie bearbeiten) gleich 0 ist, dann 
fällt der Ziehpunkt der Basislinie mit dem unteren Ziehpunkt der Hilfslinie zusammen und nur der 
Ziehpunkt der Basislinie ist wirksam.

Abbildung 17: Maßlinie 

Maßlinie anlegen
Um eine Maßlinie anzulegen, wird 
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• in der Symbolleiste Zeichnung (einschalten unter Menü Ansicht > Symbolleisten > 
Zeichnung) wird neben dem Symbol Linien und Linienspitzen im Auswahlmenü ▼ das
Symbol für Maßlinie ( ) gewählt, 

• dann wird auf das Symbol für Maßlinie ( ) in der Symbolleiste Zeichnung geklickt, der 
Cursor nimmt die Form für eine Rechteckauswahl an (abhängig vom Betriebssystem),

• durch Klicken und Ziehen wird der Anfangs- und der Endpunkt der Bemaßung gewählt; 
wird dabei die Umschalt-Taste gehalten, so wird die Richtung der Bemaßung auf exakte 
horizontale, vertikale oder diagonale Winkel eingestellt. 

Es erscheint die Maßlinie mit Beschriftung und der linken und rechten Hilfslinie sowie den 
Ziehpunkten an den Hilfslinien, siehe Abbildung 17.

Die Beschriftung kann mit einem Doppelklick auf den Text einer nicht ausgewählten Bemaßung 
bearbeitet werden. Ein Textfeld wird zur Bearbeitung geöffnet, gespeichert wird durch Klick 
außerhalb des Textfeldes oder mit der Taste Esc , der vorherige Text kann unmittelbar danach im 
Menü durch Bearbeiten > Rückgängig wieder hergestellt werden. 

Hinweis

Wenn der Text der Bemaßung bearbeitet und gelöscht wird, wird die vorgegebene 
Bemaßung wieder eingefügt, wenn das Dokument gespeichert, geschlossen und 
wieder geöffnet wird. 

Maßlinie bearbeiten
Wenn die Bemaßung ausgewählt ist, kann sie mit der rechten Maustaste im Kontextmenü mit 
Dimensionen bearbeitet werden, siehe Abbildung 18. 

Die gleichen Einstellungen werden in der Formatvorlage unter Bemaßung als Voreinstellung 
gewählt. 

Abbildung 18: Dialog Bemaßungslinie
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• Linie – setzt die Position der Maßlinie zum Objekt und die Länge der Hilfslinien, siehe 
Abbildung 17. Die Basislinie wird nicht dargestellt, sie sollte mit dem Rand des bemaßten
Objekts übereinstimmen.

– Linienabstand – gibt den Abstand der Maßlinie zum Objekt bzw. der Basislinie an.

– Hilfslinienüberhang – gibt die Länge der Hilfslinie über die Maßlinie hinaus an, bei 
einem negativen Wert endet die Hilfslinie unter der Maßlinie.

– Hilfslinienabstand – gibt (wenn Linke bzw. Rechte Hilfslinie gleich 0 sind) den Abstand
der Hilfslinien zum Objekt bzw. der Basislinie an. Bei positiven Werten berührt die 
Hilfslinie das Objekt nicht, bei negativen Werten ragt die Hilfslinie in das Objekt hinein.

– Linke bzw. Rechte Hilfslinie – verlängert die linke bzw. rechte Hilfslinie einseitig auf 
das Objekt zu, negative Werte verkürzen die Länge der Hilfslinie. Der 
Hilfslinienabstand ist dann der Abstand der Hilfslinie vom Ziehpunkt der Hilfslinie 
anstelle von der Basislinie.

– Maßlinie unterhalb des Objekts – invertiert die Position und Längen, d.h. die Maßlinie 
wird um die Basislinie gespiegelt. Die Maßlinie kann dann unterhalb bzw. links des 
Objekts angefügt werden anstelle oberhalb bzw. rechts des Objekts. Die gleiche 
Wirkung hat man, indem man beim Anlegen der Maßlinie von rechts nach links zieht 
bzw. von unten nach oben.

– Nachkommastellen – gibt an, mit welcher Genauigkeit die Maßzahl dargestellt wird. 
Zahlen, die mit weniger oder ohne Dezimalstellen dargestellt werden können, werden 
trotzdem verkürzt dargestellt.

• Beschriftung – legt die Eigenschaften des Textes für die Maßzahl fest.

– Textposition – bestimmt die Position der Beschriftung zur Maßlinie, von links nach 
rechts in Ziehrichtung beim Anlegen der Maßlinie gesehen, d.h. die Punkte links 
liegen am ersten und die Punkte rechts liegen am zweiten Punkt des Ziehens. 
Die Kontrollkästchen Automatisch Vertikal und Automatisch Horizontal dürfen nicht 
ausgewählt sein, um eine andere Textposition zu wählen. Die Textposition muss in die
Mitte gesetzt werden, um wieder Automatisch zu wählen. 

– Automatisch Vertikal – stellt die optimale vertikale Position für die Beschriftung ein.

– Automatisch Horizontal – stellt die optimale horizontale Position für die Beschriftung 
ein.

– Parallel zur Hilfslinie – wenn ausgewählt, verläuft die Schrift längs der Maßlinie, wenn 
nicht ausgewählt, verläuft die Schrift im rechten Winkel zur Maßlinie.

– Maßeinheiten anzeigen – bestimmt, ob in der Beschriftung auch die Maßeinheit oder 
nur die Zahl dargestellt wird.
In dem Auswahlfeld darunter kann die Maßeinheit der Beschriftung ausgewählt oder 
mit Automatisch entsprechend der Maßeinheit in Menü  Extras > Optionen > 
LibreOffice Draw > Allgemein gewählt werden.

Hinweis

Die Einstellungen der Bemaßung werden mit dem Dokument verknüpft und 
gespeichert. Neue Zeichnungen verwenden die Voreinstellungen. Um andere Werte 
vorzugeben, sollte eine Dokumentvorlage gespeichert werden, siehe oben unter
Dokumentvorlagen. 

Ziehpunkte
Mit Ziehpunkten kann die Maßlinie direkt in der Zeichnung verändert werden, siehe Abbildung 17:
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• Obere Ziehpunkte – beide, sowohl links als auch rechts, verändern den Abstand der 
Maßlinie zum Objekt bzw. der Basislinie (Linienabstand).

• Basislinie Ziehpunkte – ändert die Länge und den Winkel der Bemaßung als Ganzes. 
Wird dabei die Umschalt-Taste gehalten, so wird nur die Länge der Bemaßung geändert,
der Winkel wird beibehalten. Fangen am Raster, Rändern und Objekten wird 
berücksichtigt soweit dies eingestellt ist (Menü  Extras > Optionen > LibreOffice Draw 
> Raster.

• Untere Ziehpunkte – verändert jeweils die Länge der linken bzw. der rechten Hilfslinie, 
ohne die Basislinie zu verändern. 
Achtung: Wenn jedoch der untere Ziehpunkt auf die Basislinie fällt, d.h. der Wert für 
Linke bzw. Rechte Hilfslinie gleich 0 ist, dann ist das ein Basislinie Ziehpunkt, siehe 
oben.

Tipp

Für die Bemaßung von Objekten ist es sinnvoll, den Maßstab der Ansicht 
anzupassen, das Fangen am Raster und vor allem an Objekten und Hilfslinien zu 
verwenden, damit die Maßlinien exakt an ein Objekt verbunden werden können, 
siehe Kapitel 3 Arbeiten mit Objekten und Objektpunkten.

Formatvorlage
Im Dialog Maßlinien werden die Eigenschaften einer bestehenden Maßlinie bearbeitet, in der 
Zeichnungsvorlage Pfeillinie (nicht Zeichnungsvorlage Standard) werden dagegen die 
Eigenschaften bearbeitet, die eine neu erstellte Maßlinie erhält. 

Der Dialog Formatvorlagen Pfeillinie wird geöffnet  

• während eine Maßlinie ausgewählt ist, mit dem Menü Format >  Formatvorlagen >  
Formatvorlage bearbeiten,

• während eine Maßlinie ausgewählt ist, mit der rechten Maustaste im Kontextmenü mit  
Formatvorlage bearbeiten, 

• indem die Seitenleiste Formatvorlagen eingeblendet wird 

– in der Symbolleiste Linie und Füllung (einschalten über Menü Ansicht > 
Symbolleisten > Linie und Füllung) mit Klicken auf Formatvorlagen anzeigen   

– mit dem Tastaturkürzel F11 ,

– im Menü über Ansicht > Formatvorlagen

und mit Rechtsklick auf die Formatvorlage Pfeillinie (nicht Standard) und Ändern.

In der Formatvorlage Pfeillinie im Reiter Bemaßung werden die gleichen Einstellungen als 
Voreinstellung gewählt wie im Dialog Bemaßungslinie, für die Bedeutung der Einstellungen siehe
oben Maßlinie bearbeiten und Abbildung 18. 

Mit Standard werden die Einstellungen der Formatvorlage auf die Voreinstellung zurückgesetzt.

Farben

Wie alle LibreOffice-Module verwendet Draw Farben, die in Farbpaletten zusammengefasst sind.
Farben können dem Bedarf entsprechend selbst erzeugt werden, diese werden in die 
Benutzerdefinierte Farbpalette aufgenommen. Die folgenden Farbräume können verwendet 
werden, um eine Farbe zu erzeugen:
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• RGB – bedeutet Rot, Grün, Blau. Das RGB-Farbmodell basiert auf der additiven 
Zusammensetzung aus Licht aus den Grundfarben und wurde für Anzeigegeräte wie 
Computermonitore entworfen. Jede der drei Grundfarben kann einen Wertebereich von 0
bis 255 annehmen. Schwarz wird durch R=0, G=0 und B=0 dargestellt, je größer die 
zahlenmäßigen Farbanteile sind, desto heller ist die Farbe, weiß wird mit R=255, G=255 
und B=255 dargestellt. LibreOffice verwendet zum Drucken intern das RGB-Farbmodell 
in allen Modulen.

• CMYK – bedeutet Cyan, Magenta, Yellow (Gelb), Key (Schwarz). Das CMYK-Farbmodell
basiert auf der subtraktiven Zusammensetzung des Lichts und beschreibt den 
Vierfarbdruck, daher sind üblicherweise die Farbpatronen von Druckern mit C, M, Y und 
K bezeichnet. Der Wertebereich der Farbkomponenten reicht von 0 bis 100, mit C=100, 
M=100, Y=100 und K=100 wird schwarz dargestellt, mit C=0, M=0, Y=0 und K=0 wird 
weiß dargestellt.

• HSB – bedeutet Hue (Farbton), Saturation (Sättigung), Brightness (Stärke). Das HSB-
Farbmodell ist eine Alternative zu RGB, die mehr der Farbwahrnehmung des Auges 
entspricht. Man benutzt HSB, um selbst erstellte Farben an die gewünschte Farbe 
anzupassen.

Tipp

Eine ausführlichere Beschreibung der Farbmodelle findet sich unter 
https://de.wikipedia.org/wiki/Farbe#Farbmodelle.

Um die Farbe eines Objekts zu ändern, werden Farbpaletten eingesetzt, die in LibreOffice 
vorinstalliert sind und in allen Modulen verwendet werden. Ihre Verwendung ist über alle 
Objekttypen hinweg ähnlich, nur der Zugriff der Farbpaletten ist spezifisch für verschiedene 
Objekte.

Farbleiste
In LibreOffice kann eine Farbe exakt eingestellt werden, sie kann jedoch schneller über eine 
Farbleiste (Abbildung 19) ausgewählt werden, um die Farbe für eine Füllung oder Umrandung 
oder für Linien eines Objekts zu setzen: 

• Auswählen eines Objekts in einer Zeichnung, 

• im Menü Ansicht > Farbleiste wählen, um die Farbleiste zu öffnen, 

• Linksklick auf die Farbe, um die Farbe der Füllung zu wählen, 
Rechtsklick auf die Farbe, um die Farbe der Umrandung bzw. einer Linie zu wählen. 

• Linksklick auf das X in der linken unteren Ecke, um die Farbe der Füllung zu löschen, 
Rechtsklick auf das X in der linken unteren Ecke, um die Farbe der Umrandung bzw. 
einer Linie zu löschen, 

• im Menü Ansicht > Farbleiste abwählen, um die Farbleiste zu schließen. 
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Abbildung 19: Farbleiste

Hinweis

Die Farben der Farbleiste umfassen die Standard-Farbpalette, die Teil der 
LibreOffice-Installation ist.

Füllfarbe im Dialog Fläche
Die Füllfarbe von Objekten kann im Dialog Fläche gewählt werden

• Auswählen eines Objekts in einer Zeichnung,

• im Menü Format > Fläche oder Rechtsklick auf das Objekt und Fläche wählen, 

• es öffnet sich der Dialog Fläche (Abbildung 20), wählen des Reiters Fläche und darin die 
Auswahl Farbe, 

• unter Farben im Auswahlmenü Palette eine der Farbpaletten wählen, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendete Farben klicken, 

• mit OK die Farbe übernehmen und den Dialog schließen. 

Abbildung 20: Dialog Fläche mit Auswahl Farbe
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Füllfarbe in der Symbolleiste Linie und Füllung
In der Symbolleiste Linie und Füllung (einschalten über Menü Ansicht > Symbolleisten > Linie 
und Füllung) kann die Farbe für Flächen gewählt werden: 

• Auswählen eines Objekts in einer Zeichnung,

• in der Symbolleiste das Auswahlmenü ggf. von Ohne auf Farbe umstellen, 

• mit dem Auswahlmenü Füllfarbe  die Farbpalette öffnen, 

• darin im Auswahlmenü eine der Farbpaletten wählen, z. B. standard, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendet klicken, 

die Farbe wird der Füllung des Objekts zugewiesen. 

Füllfarbe in der Seitenleiste
In der Seitenleiste (einschalten über Menü Ansicht > Seitenleiste) mit Auswahl 
Eigenschaften   (Abbildung 21) kann die Farbe gewählt werden: 

• Auswählen eines Objekts in einer Zeichnung,

• im Abschnitt Fläche im Auswahlmenü Füllung Farbe wählen, 

• darunter im Auswahlmenü ▼ die Farbpalette öffnen

• im Auswahlmenü eine der Farbpaletten wählen, z. B. standard, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendet klicken, 

• die Farbe wird der Füllung des Objekts zugewiesen.

Abbildung 21: Seitenleiste Fläche mit Farbpalette

Linienfarbe im Dialog Linie
Die Linienfarbe von Objekten kann im Dialog Linie gewählt werden

• Auswählen eines Objekts in einer Zeichnung,
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• im Menü Format > Linie oder Rechtsklick auf das Objekt und Linie wählen, 

• es öffnet sich der Dialog Linie (Abbildung 22), wählen des Reiters Linie, 

• im Auswahlmenü Farbe eine der Farbpaletten wählen, z. B. standard, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendete Farben klicken, 

• mit OK die Farbe übernehmen und den Dialog schließen. 

Abbildung 22: Dialog Linie mit Farbpalette

Linienfarbe in der Symbolleiste Linie und Füllung
In der Symbolleiste Linie und Füllung (einschalten über Menü Ansicht > Symbolleisten > Linie 
und Füllung) kann die Farbe für Linien gewählt werden: 

• Auswählen einer Linie in einer Zeichnung,

• Klick auf das Farbfeld im Symbol Linienfarbe , 

• die angezeigte Farbe wird der Linie sofort zugewiesen. 

oder

• Auswählen einer Linie in einer Zeichnung,

• mit dem Auswahlmenü im Symbol Linienfarbe  oder einem langen Klick auf das 
Symbol die Farbpalette öffnen, 

• darin im Auswahlmenü eine der Farbpaletten wählen, z. B. standard, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendet klicken, 

die Farbe wird der Füllung des Objekts zugewiesen. 

Linienfarbe in der Seitenleiste
In der Seitenleiste (einschalten über Menü Ansicht > Seitenleiste) mit der Auswahl 
Eigenschaften   (Abbildung 23) kann die Farbe gewählt werden: 

• Auswählen eines Objekts in einer Zeichnung,

• in der Seitenleiste im Abschnitt Linie unter Farbe mit dem Auswahlmenü ▼ die 
Farbpalette öffnen

• im Auswahlmenü darin eine der Farbpaletten wählen, z. B. standard, 
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• auf eine der Farben in der Palette oder unter Zuletzt verwendet klicken, 

• die Farbe wird der Füllung des Objekts zugewiesen.

Abbildung 23: Seitenleiste Linie mit Farbpalette

Textfarbe im Dialog Zeichen
Farbe für Texte teilt sich ein in Zeichenfarbe und die Farbe für Texthervorhebung, beides kann im
Dialog Zeichen zugewiesen werden:

Zeichenfarbe
• Text in einem Textfeld oder einem anderen Objekt auswählen, 

• im Menü Format > Zeichen oder Rechtsklick auf den Text und Zeichen wählen, 

• es öffnet sich der Dialog Zeichen, wählen des Reiters Schrifteffekte (Abbildung 24), 

• das Auswahlmenü Schriftfarbe öffnen und darin 

– entweder Automatisch wählen oder

– eine der Farbpaletten wählen, z. B. standard und 
auf eine der Farben in der Palette oder unter Zuletzt verwendet klicken, 

• mit OK die Farbe übernehmen und den Dialog schließen. 

Texthervorhebung
• Text in einem Textfeld oder einem anderen Objekt auswählen, 

• im Menü Format > Zeichen oder Rechtsklick auf den Text und Zeichen wählen, 

• es öffnet sich der Dialog Zeichen, wählen des Reiters Hervorhebung und darin die 
Auswahl Farbe (der Dialog entspricht dem Dialog Fläche, vgl. Abbildung 20),

• unter Farben im Auswahlmenü Palette eine der Farbpaletten wählen, z. B. standard, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendete Farben klicken, 

• mit OK die Farbe für Texthervorhebung übernehmen und den Dialog schließen.
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Abbildung 24: Dialog Zeichen - Schrifteffekte mit Auswahlmenü Schriftfarbe

Textfarbe in der Symbolleiste Textformat
Beim Markieren von Text öffnet sich automatisch die Symbolleiste Textformat (ein- und 
ausschalten über Menü Ansicht > Symbolleisten > Textformat). Hier kann die Zeichenfarbe 
und die Farbe für Texthervorhebung gewählt werden: 

Zeichenfarbe
• Text in einem Textfeld oder einem anderen Objekt auswählen,

• Klick auf das Buchstabenfeld  im Symbol Zeichenfarbe , 

• die angezeigte Zeichenfarbe wird dem Text sofort zugewiesen. 

oder

• Text in einem Textfeld oder einem anderen Objekt auswählen,

• mit dem Auswahlmenü ▼ im Symbol Zeichenfarbe  oder einem langen Klick auf das 
Symbol die Farbpalette öffnen, 

• darin im Auswahlmenü eine der Farbpaletten wählen, z. B. standard, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendet klicken, 

• die Zeichenfarbe wird dem Text zugewiesen. 

Texthervorhebung
• Text in einem Textfeld oder einem anderen Objekt auswählen,
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• Klick auf das Markierfeld  im Symbol Texthervorhebung , 

• die angezeigte Texthervorhebung wird dem Text sofort zugewiesen. 

oder

• Text in einem Textfeld oder einem anderen Objekt auswählen,

• mit dem Auswahlmenü ▼ im Symbol Texthervorhebung  die Farbpalette öffnen, 

• darin im Auswahlmenü eine der Farbpaletten wählen, z. B. standard, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendet klicken, 

• die Texthervorhebung wird dem Text zugewiesen. 

Textfarbe in der Seitenleiste
In der Seitenleiste (einschalten über Menü Ansicht > Seitenleiste) mit der Auswahl 
Eigenschaften   (Abbildung 25) kann die Farbe gewählt werden: 

Zeichenfarbe
• Text in einem Textfeld oder einem anderen Objekt auswählen,

• Klick auf das Buchstabenfeld  im Symbol Zeichenfarbe , 

• die angezeigte Zeichenfarbe wird dem Text sofort zugewiesen. 

oder

• Text in einem Textfeld oder einem anderen Objekt auswählen,

• in der Seitenleiste im Abschnitt Zeichen mit dem Auswahlmenü ▼ im Symbol 
Zeichenfarbe  die Farbpalette öffnen, 

• darin im Auswahlmenü eine der Farbpaletten wählen, z. B. standard, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendet klicken, 

• die Zeichenfarbe wird dem Text zugewiesen. 

Texthervorhebung
• Text in einem Textfeld oder einem anderen Objekt auswählen,

• Klick auf das Markierfeld  im Symbol Farbe der Zeichenhervorhebung , 

• die angezeigte Texthervorhebung wird dem Text sofort zugewiesen. 

oder

• Text in einem Textfeld oder einem anderen Objekt auswählen,

• in der Seitenleiste im Abschnitt Zeichen mit dem Auswahlmenü ▼ im Symbol Farbe der 
Zeichenhervorhebung  die Farbpalette öffnen, 

• darin im Auswahlmenü eine der Farbpaletten wählen, z. B. standard, 

• auf eine der Farben in der Palette oder unter Zuletzt verwendet klicken, 

• die Texthervorhebung wird dem Text zugewiesen. 
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Abbildung 25: Seitenleiste - Zeichen - Zeichenfarbe mit Farbpalette

Farben erstellen
Eigene Farben werden erstellt in den oben beschriebenen 

• Dialogen für Füllfarbe oder Zeichen-Hervorhebung jeweils im Reiter Farbe unter Neue 

– bei bekannten RGB-Werten oder Hex-Wert direkt durch Eingabe 
▫ in die Felder für R, G, und B als Zahlen oder durch Klicken auf  -  und  +  oder 
▫ im Feld für den sechsstelligen Hex-Wert, 

– durch Klicken auf Auswählen, um den Dialog Farbauswahl zu öffnen, 

• Menüs und Seitenleisten für Füllfarbe, Linienfarbe, Textfarbe oder Zeichen-Hervorhebung
jeweils in der Farbpalette 

– mit der Auswahl Benutzerdefinierte Farbe , um den 

Dialog Farbauswahl zu öffnen.

Im Dialog Farbauswahl (Abbildung 26) 

unter RGB 

• klicken auf Rot und durch Klicken oder Ziehen auf den vertikalen Farbbalken den Rot-
Anteil, dann durch Klicken oder Ziehen im zweidimensionalen Farbfeld vertikal den Grün-
Anteil und horizontal den Blau-Anteil wählen oder

• klicken auf Grün und durch Klicken oder Ziehen auf den vertikalen Farbbalken den Grün-
Anteil, dann durch Klicken oder Ziehen im zweidimensionalen Farbfeld vertikal den Rot-
Anteil und horizontal den Blau-Anteil wählen oder
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• klicken auf Blau und durch Klicken oder Ziehen auf den vertikalen Farbbalken den Blau-
Anteil, dann durch Klicken oder Ziehen im zweidimensionalen Farbfeld vertikal den Grün-
Anteil und horizontal den Rot-Anteil wählen. 

oder unter HSB 

• klicken auf Farbton und durch Klicken oder Ziehen auf den vertikalen Farbbalken den 
Farbton, dann durch Klicken oder Ziehen im zweidimensionalen Farbfeld vertikal die 
Helligkeit und horizontal die Sättigung wählen (empfohlen für die manuelle Farbwahl) 
oder

• klicken auf Sättigung und durch Klicken oder Ziehen auf den vertikalen Farbbalken die 
Sättigung, dann durch Klicken oder Ziehen im zweidimensionalen Farbfeld vertikal die 
Helligkeit und horizontal den Farbton wählen oder

• klicken auf Helligkeit und durch Klicken oder Ziehen auf den vertikalen Farbbalken die 
Helligkeit, dann durch Klicken oder Ziehen im zweidimensionalen Farbfeld vertikal die 
Sättigung und horizontal den Farbton wählen. 

oder unter CMYK 

• eingeben der Zahlenwerte für Cyan, Magenta, Gelb (Yellow), Key (Schwarz) in die 
Felder.

Das horizontale Farbfeld unter dem zweidimensionalen Farbfeld zeigt in der linken Hälfte die 
gewählte Farbe und in der rechten Hälfte die aktuelle Farbe des selektierten Objekts. 

Tipp

Da HSB am ehesten der Farbwahrnehmung des Auges entspricht, ist es vorteilhaft, 
für selbst erstellte Farben wie in Abbildung 26 gezeigt unter HSB Farbton 
anzuklicken, den Farbton im vertikalen Farbbalken zu wählen und Sättigung und 
Helligkeit im zweidimensionalen Farbfeld an die gewünschte Farbe anzupassen.

Abbildung 26: Dialog Farbauswahl

42 | Kapitel 11 Fortgeschrittene Zeichentechniken



Die erstellte Farbe kann 

• durch Klicken auf Hinzufügen mit einem Namen versehen und zur Palette 
Benutzerdefiniert hinzugefügt werden und 

• mit OK auf das zuvor ausgewählte Objekt oder den Text angewendet werden. 

Hinweis

In die Palette Benutzerdefiniert kann die erstellte Farbe nur über den Dialog Fläche
und nicht über die Farbpalette in den Symbolleisten und Seitenleisten hinzugefügt 
werden. Lediglich mithilfe des Zuletzt verwendete Farben kann diese Farbe später 
hinzugefügt werden. Wird die erstellte Farbe auf das Objekt angewendet aber nicht 
zur Palette Benutzerdefiniert hinzugefügt, dann erhält sie in den Zuletzt verwendete 
Farben einen Namen, der aus dem sechsstelligen Hex-Wert gebildet wird. 

Benutzerdefinierte Farben hinzufügen
Farben, die im Dialog Fläche oder unter Zeichen Hervorhebung gewählt wurden, sowohl aus 
der Palette als auch selbst mit Auswählen erstellte, können in der Farbpalette 
Benutzerdefiniert gespeichert werden. 

Dazu wird 

• die Farbe unter Farben in der Palette gewählt oder unter Neue mit Auswählen erstellt 
und anschließend 

• unter Palette anpassen mit Hinzufügen angeklickt, 

• im Dialog Name kann die Farbe benannt und mit OK gespeichert werden.

Hinweis

Benutzerdefinierte Farben können nicht umbenannt werden, jedoch kann eine Farbe
aus der Palette Benutzerdefiniert angeklickt, mit Hinzufügen ein zweites Mal mit 
anderem Namen in die Liste eingetragen und die vorherige Farbe gelöscht werden. 

Benutzerdefinierte Farben löschen
Farben in der Farbpalette Benutzerdefiniert können gelöscht werden:

• im Dialog Fläche oder unter Zeichen Hervorhebung unter Farben im Auswahlmenü 
Palette Benutzerdefiniert wählen, 

• die zu löschende Farbe anklicken,  

• unter Palette anpassen Löschen anklicken. 

Vorsicht

Die benutzerdefinierte Farbe wird ohne Rückfrage endgültig gelöscht und kann nicht 
mit dem Befehl Rückgängig wiederhergestellt werden!

Gallery

LibreOffice Draw verfügt über eine Gallery, in der eine Vielzahl von grafischen Objekten 
vorbereitet sind, um sie in Zeichnungen einzufügen und darin den Bedürfnissen anzupassen.

Die verfügbaren Objekte sind nach Themen gruppiert

• Aufzählungszeichen

Gallery | 43



• BPMN (Geschäftsprozessnotation, siehe Wikipedia)

• Diagramme

• Flussdiagramme

• Formen

• Klänge

• Netzwerk

• Symbole

Die Objekte der Gallery finden sich in der Seitenleiste Gallery (Abbildung 27) , die angezeigt wird

• mit Menü Ansicht > Gallery

• mit Menü Einfügen > Medien > Gallery 

• in der Seitenleiste über das Symbol Gallery 

Durch Klicken auf ein Thema in der oberen Hälfte werden unten die Grafiken angezeigt. 

Abbildung 27: Seitenleiste Gallery in Symbolansicht

Am unteren Rand der Seitenleiste kann die Darstellung der Objekte gewählt werden zwischen 

• Symbolansicht ‒ grafisch in einem Raster und

• Detailansicht ‒ zeilenweise mit zugehörigem Namen. 

Mit einem Doppelklick auf das jeweilige Objekt oder Rechtsklick und Vorschau wählen wird eine 
vergrößerte Ansicht gezeigt, diese wird beendet durch erneuten Doppelklick oder Rechtsklick 
und Vorschau deselektieren. Wenn der Cursor zu einer Symbolform wird, kann mit Klicken in der
Zeichnung das Objekt eingefügt oder mit erneutem Klick auf das Objekt oder der Taste Esc  
abgebrochen werden. 

Objekt aus Gallery einfügen
Ein Objekt der Gallery wird aus der Seitenleiste (siehe Abbildung 27) eingefügt, indem oben das 
Gallery-Thema gewählt wird, dann unten das Objekt auswählen mit 
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• Klicken und Ziehen an die gewünschte Position in der Zeichnung (Abbrechen mit der 
Taste Esc )

• Rechtsklick und Einfügen, das Objekt wird in der Mitte der Folie platziert 

• Rechtsklick und Kopieren, der Cursor wird zu einer Symbolform (Abbrechen mit der 
Taste Esc ), in der Zeichnung Klicken an der gewünschte Position

• Doppelklick, die Vorschau wird sichtbar, der Cursor wird zu einer Symbolform 
(Abbrechen mit der Taste Esc ), in der Zeichnung Klicken an der gewünschte Position; 
die Vorschau wird beendet durch erneuten Doppelklick oder Rechtsklick und Vorschau 
deselektieren. 

Nach dem Einfügen aus der Gallery kann das Objekt wie jedes andere Objekt bearbeitet werden.

Themen und Objekte anlegen
Zu den mit LibreOffice Draw installierten Themen und Objekten können eigene Themen und 
Objekte hinzugefügt werden.

Mit einem Klick auf Neu am unteren Rand der Seitenleiste (siehe Abbildung 27) öffnet sich der 
Dialog Eigenschaften für das neue Thema (siehe Abbildung 28), 

• im Reiter Allgemein wird der Name des neuen Themas eingetragen,

• im Reiter Dateien wird mit Dateien suchen ein Dateiordner im Rechner gewählt. Mit dem
Kontrollkästchen Vorschau kann eine Ansicht des ausgewählten Objektes ein- und 
ausgeschaltet werden. Die Dateien aus diesem Ordner können

– einzeln mit Hinzufügen oder 

– alle mit Alle hinzufügen 

als Objekte in dem eigenen Gallery-Thema angelegt werden. 

Abbildung 28:  Dialog Gallery Eigenschaften
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Eigene Themen bearbeiten
Themen und Objekte der Gallery, die selbst erstellt wurden, können weiter bearbeitet oder 
gelöscht werden. In LibreOffice Draw vorbereitete Themen und Objekte können nicht bearbeitet 
oder gelöscht werden. 

Themen
Mit einem Rechtsklick auf ein eigenes Thema in der oberen Hälfte der Seitenleiste stehen im 
Kontextmenü diese Operationen zur Auswahl: 

• Mit Umbenennen kann der Name geändert werden. 

• Mit Löschen wird nach einer Rückfrage das Thema mit allen darin enthaltenen Objekten 
gelöscht. Das Thema und die Objekte können nicht mit mit dem Befehl Rückgängig 
wiederhergestellt werden. 
Damit werden nicht die zugefügten Dateien selbst gelöscht sondern lediglich die 
Verlinkung, siehe Hinweis unten. 

• Mit Aktualisieren werden die Objekte des Themas überprüft, als Datei nicht mehr 
existierende Objekte werden entfernt, siehe Hinweis unten. 

• Durch Eigenschaften wird der Dialog Eigenschaften geöffnet (siehe Abbildung 28). 
Hier kann wie in Themen und Objekte anlegen beschrieben im Reiter Allgemein der 
Name des Themas geändert werden, im Reiter Dateien können weitere Dateien 
hinzugefügt werden. 

Objekte
Mit einem Rechtsklick auf ein Objekt in einem eigenen Thema in der unteren Hälfte der 
Seitenleiste stehen im Kontextmenü diese Bearbeitungsmöglichkeiten zur Auswahl: 

• Mit Titel kann der in der Detailansicht angezeigte Name des Objekts geändert werden. 

• Mit Löschen wird nach einer Rückfrage das Objekt gelöscht, es kann nicht mit mit dem 
Befehl Rückgängig wiederhergestellt werden. 
Damit wird nicht die Datei selbst gelöscht sondern lediglich die Verlinkung, siehe Hinweis
unten. 

Hinweis

Die Objekte in den eigenen Themen der Gallery bestehen in Verlinkungen auf die 
hinzugefügten Dateien. Objekte, die als Dateien nicht mehr bestehen, können nicht 
in eine Zeichnung eingefügt werden. Löschen der Objekte in der Gallery löscht 
lediglich die Verlinkung, nicht die Originaldatei selbst. 

Diagramme

Diagramme werden vor allem in Calc benutzt, wo sie direkt mit einem Rechteck von Zellen ver-
knüpft sind, die die Daten für das Diagramm liefern. Wenn Sie Diagramme in der hier beschrie-
benen Form in Draw (oder auch Impress oder Writer) nutzen wollen, müssen Sie die Daten 
selbst eingeben, sie bleiben jedoch änderbar. Es gibt auch die Möglichkeit, Tabelle und 
Diagramm über Calc zu erstellen und einzufügen, dies wird in „OLE-Objekte“ auf Seite 48 
beschrieben.

Neben dem Menüpfad Einfügen ► Medien ► Diagramm... erreichen Sie diese Funktion auch 
über

• das Menü Einfügen im Register Einfügen der Benutzeroberflächen In Registern und In 
Registern kompakt
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• über die Auswahlliste Menü in der Benutzeroberfläche Gruppiert kompakt

Nach Auswahl dieser Funktion wird ein Standard-Diagramm mittig in der Folie eingefügt 
(Abbildung 29, das Kontextmenü ist dann noch nicht sichtbar, es wird weiter unten beschrieben).

Das Diagramm enthält zunächst nur Beispieldaten, nämlich eine Tabelle mit vier Zeilen mit 
jeweils drei Werten, die Sie in Abbildung 30 sehen können. Es sind nur neutrale Beschriftungen 
zu sehen, ein Titel fehlt noch gänzlich.

Sie können nun das Diagramm Ihren Wünschen anpassen. Das Wichtigste sind zunächst einmal 
die zugrunde liegenden Daten.

Um die wesentlichen Änderungen am Diagramm vorzunehmen, wählen Sie es zunächst einmal 
aus und aktivieren es dann über Doppelklick oder Eingabe zur Bearbeitung. Dann können Sie ein
Kontextmenü aufrufen, das, je nachdem, wo sich der Mauszeiger befindet, etwas unterschiedlich 
aussieht, jedoch immer die wesentlichsten Menüpunkte enthält, insbesondere den Punkt 
Datentabelle.... Abbildung 30 zeigt das Kontextmenü nach Klick in den freien Teil des Objekts, 
außerhalb der Diagrammfläche und der Bezeichner.

Abbildung 29: Eingefügtes Diagramm mit dem Kontextmenü

Wählen Sie den Menüpunkt Datentabelle…, sie erhalten dann den in Abbildung 30 gezeigten 
Dialog.
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Abbildung 30: Initiale Datentabelle

Sie können mit den Symbolen im Kopf, die zum Teil schon aus der Arbeit mit Tabellen in Writer 
oder Draw vertraut sind, die Tabelle verändern:

• Zeile einfügen: dies erfolgt immer nach der Zeile, in der der Cursor steht.

• Datenreihe einfügen: was sonst meist Spalte genannt wird, wird hier häufig als 
Datenreihe bezeichnet; die Einfügung erfolgt nach der Spalte in der der Cursor steht.

• Textspalte einfügen: eine Textspalte ist eine, die keine Zahlenwerte für das Diagramm 
enthält, sondern Text für die Beschriftung, wie in der Abbildung die Spalte Kategorien. Sie
wird direkt vor den Zahlenspalten (Datenreihen) eingefügt.

• Zeile löschen: löscht die Zeile, die den Cursor enthält.

• Datenreihe löschen: löscht die Spalte, die den Cursor enthält, sowohl eine Datenreihe 
als auch eine Textspalte.

• Spalte nach links oder rechts verschieben, Zeile nach oben oder unten 
verschieben: Damit können Sie Reihenfolge in beiden Dimensionen beeinflussen, 
insbesondere notwendig, wenn Sie vor der ersten Zeile oder Datenspalte etwas einfügen
wollen, das Sie ja zunächst nur danach platzieren konnten.

Anschließend können Sie die Daten der Tabelle nach Ihren Bedürfnissen abändern.

Die weitere Anpassung des Diagramms kann im Rahmen dieses Handbuchs nicht mehr 
beschrieben werden, Sie finden Näheres im Handbuch zu Calc.

OLE-Objekte

OLE ist die Abkürzung für Object Linking and Embedding (Objekt-Verknüpfung und Einbettung). 
Diese Technik ermöglicht es, in ein Dokument den Inhalt eines anderen Dokuments einzufügen –
entweder als Kopie (Einbettung) oder als Verknüpfung. Dieses Verfahren setzt voraus, dass die 
Anwendung, mit der dieses Dokument erstellt wurde, OLE-fähig ist, und dass sie auch auf dem 
Rechner, auf dem die Datei ausgeführt wird, verfügbar ist. Das unten gezeigte Beispiel demon-
striert das mit einer kleinen Calc-Tabelle samt zugehörigem Diagramm, die in einem Zeichnungs-
dokument entweder als „Kopie“ eingebettet oder als Verknüpfung eingefügt wird.
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Sie erreichen diese Funktion über Einfügen ► Objekt ► OLE-Objekt…

Daraufhin erscheint der in Abbildung 31 gezeigte Dialog:

Abbildung 31: Der Dialog OLE-Objekt einfügen

OLE-Objekt neu erstellen
Sie haben einerseits die Möglichkeit, ein neues OLE-Objekt einzufügen (linker Teil der 
Abbildung). Die Auswahlliste bietet dafür zunächst die möglichen Objekttypen von LibreOffice an,
über den letzten Punkt der Liste „Weitere Objekte“ und OK wird ein neuer Dialog geöffnet, in dem
Sie verfügbare Objekttypen aus anderen Anwendungen auswählen können; die Auswahl, die hier
angeboten wird, hängt vom Betriebssystem und den installierten Anwendungen ab.

Sie können in diesem Fall auch ein bestehendes Dokument als Quelle für das OLE-Objekt 
benennen, das erzeugte OLE-Objekt ist aber auf jeden Fall eingebettet und dann eben zu Beginn
eine Kopie der Quelle. Die Datei können Sie beliebig mit dem Datei-Explorer auswählen, es ist 
aber nicht zu erwarten, dass OLE mit allen Dateien funktioniert, denn die Anwendung, die zu 
dieser Datei gehört, muss selber OLE unterstützen. Wenn die Datei einem der genannten 
Objekttypen, ob nun von LibreOffice oder den unter „Weitere Objekte“ genannten, entspricht, 
sollte ein brauchbares Ergebnis erzielt werden. PDF z. B. funktioniert auch, ob das Ergebnis 
verwendbar ist, müssen Sie selbst überprüfen.

OLE-Objekt aus Datei erstellen
Die andere Möglichkeit ist, ein bestehendes Dokument einzufügen. Geben Sie im Feld Datei den 
Pfad der Datei ein oder suchen Sie ihn mit der Schaltfläche Suchen über den Dateiexplorer. Hier 
gilt das im vorigen Abschnitt Geschriebene, dass die Datei bzw. die Anwendung, mit der sie 
erstellt wurde, OLE unterstützen muss. Ein brauchbares Ergebnis sollten Sie auf jeden Fall 
erhalten, wenn Sie eine Datei von LibreOffice auswählen, oder eine, die einem der über „Weitere
Objekte“ im vorigen Abschnitt „OLE-Objekt neu erstellen“ aufgelistet werden.

Sie haben zusätzlich zwei Optionen:

• Mit Datei verknüpfen: Wenn Sie dieses Markierfeld aktivieren, wird eine Verknüpfung zu
der Datei eingefügt, das Zeichnungs-Dokument ist dann mit dieser Datei verbunden, eine
Änderung in dieser Datei ist im Zeichnungsdokument sichtbar, wenn Sie es wieder 
öffnen, und einen Änderung, die Sie an der verknüpften Datei im Zeichnungs-Dokument 
vornehmen, wird sofort in der Originaldatei wirksam.
Beim erneuten Öffnen des Zeichnungsdokuments werden Sie gefragt, ob alle 
Verknüpfungen aktualisiert werden sollen, wenn Sie dies verneinen, wird das OLE-Objekt
eingebettet, wie im folgenden Abschnitt beschrieben.
Wenn Sie das Markierfeld deaktiviert lassen, wird eine Kopie der Datei (bzw. des 
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wesentlichen Teils davon, Sie sehen z. B. bei einer LibreOffice-Datei keine Menüs und 
Symbolleisten) in das Zeichnungsdokument eingefügt (die dadurch natürlich auch größer
wird). Die eingefügt Kopie ist aber nun unabhängig von der Quelle und nicht mehr mit 
dieser verbunden.

• Als Symbol anzeigen: Ist dieses Markierfeld aktiviert, so wird nicht die Datei angezeigt, 
sondern nur ein Symbol, das diese repräsentiert. Durch Doppelklick können Sie die Datei
öffnen.

Abbildung 32 zeigt die verschiedenen Varianten am Beispiel einer winzigen Calc-Tabelle mitsamt
zugehörigem Diagramm:

Abbildung 32: Beispiel für das Einfügen eines OLE-Objekts

• Links die eingebettete Kopie, die Option Mit Datei verknüpfen ist deaktiviert. Die Größe 
des eingebetteten Objekts können Sie wie bei sonstigen Zeichnungsobjekten verändern

• Daneben die verknüpfte Datei, die Option Mit Datei verknüpfen ist aktiviert. Hier ist eine
recht kleine Größe gewählt worden.

• Daneben wird gezeigt, wie sich das Objekt zeigt, wenn es durch Doppelklick geöffnet 
wurde. Sie sehen die Zeilen- und Spaltenköpfe, wie Sie sie von Calc kennen, sie können 
sogar zwischen mehreren Tabellen wechseln und neue hinzufügen, und über das 
Kontextmenü können Sie auch Zeilen und Spalten hinzufügen und löschen, kurz: die 
wesentlichen Funktionen von Calc stehen zur Verfügung.

• Das Bild rechts zeigt eine verknüpfte Datei, bei der anstelle des Inhalts nur ein Symbol 
angezeigt wird; ein Doppelklick öffnet dann sogar die Originalanwendung, mit der das 
Objekt erstellt wurde.

Formeln

Wenn Sie diese Funktion über Einfügen ► Objekt ► Formel auswählen, wird in Draw der 
Formeleditor von Math geöffnet, über das Sie Näheres im zugehörigen Kapitel des Handbuchs 
Erste Schritte oder ausführlicher im Handbuch Math nachlesen können.

Wenn Sie die Formel eingegeben haben, klicken Sie im Arbeitsbereich außerhalb der Folie, dann
wird wieder die übliche Ansicht von Draw hergestellt.

Bézierkurven und Polygone

Theorie der Bézierkurven
Bézierkurven sind ein sehr allgemeines Konzept, das hier nicht im Detail erläutert werden kann, 
Sie können nähere Informationen z. B. bei Wikipedia finden. LibreOffice verwendet Bézierkurven 
bis zum Grad 3. Eine gerade Linie,wenn sie denn als Bézierkurve realisiert wird, wie das bei der 
Geraden im Teil a) der Abbildung 36 der Fall ist, ist eine Bézierkurve des Grades 1, eine Kurve, 
deren Geometrie durch einen einzigen zusätzlichen Punkt bestimmt wird, wie in den Teilen b) bis 
d) der Abbildung 36, hat den Grad 2, der Grad 3 ist im Teil e) der Abbildung dargestellt, wo zwei 
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unabhängige Punkte, hier nur als Endpunkte der beiden blau gestrichelten Geraden 
identifizierbar, die Form der Kurve bestimmen.

Abbildung 33: Bézierkurve: Prinzip und Beispiele für Steuerpunkte

Der linke Teil dieser Abbildung zeigt eine Bezierkurve, nach dem gleichen Prinzip erzeugt wie in 
Abbildung 36 Zeichnen einer Kurve. Die Punkte P0 und P3 sind die Anfangs- und Endpunkte der 
Kurve. P1 und P2 sind Steuerpunkte für die Kurve: die Richtung der Linie P0 – P1 bestimmt die 
Tangente der Kurve in P0, die Länge dieser Linie bestimmt die Krümmung der Kurve an dieser 
Stelle; das Gleiche gilt entsprechend für die anderen beiden Punkte. LibreOffice benutzt diese 
optischen Hilfsmittel, um Parameter der Bézierkurve zu repräsentieren.

Der mittlere Teil von Abbildung 33 zeigt die Auswirkung einer Änderung der Länge der Linie P0 – 
P1: weil die Linie kürzer ist, ist die Krümmung der Bézierkurve in P0 stärker.

Der rechte Teil zeigt ein Beispiel, bei dem sowohl die Richtung als auch die Länge (wenngleich 
weniger merklich) der Linie P3 – P2 verändert wurde; die Krümmung der Kurve nahe P0 ist zwar 
noch die gleiche, aber je mehr die Kurve sich P3 nähert, desto mehr passt sie sich der 
Anforderung des rechten Steuerpunkts P2 an.

Typen von Punkten
Die Punkte P0 und P3 werden als Kurvenpunkte bezeichnet, die Punkte P1 und P2 als 
Steuerpunkte.

Kurvenpunkte
Die Punkte einer (meist zusammengesetzten) Kurve können unterschiedliche Eigenschaften 
haben (Abbildung 34, die ursprünglichen Steuerpunkte und -linien sind schwächer angedeutet):

• Eckpunkt: Kurven, die in diesem Punkt enden, können unterschiedliche Tangenten, d. h. 
Austrittswinkel haben; für die Krümmungen gilt das natürlich erst recht.

• Glatter Punkt: Kurven, die in diesem Punkt enden, haben gleiche Tangenten; mathema-
tisch ausgedrückt ist die Kurve an dieser Stelle differenzierbar. Aber die Krümmungen 
können unterschiedlich sein, was sich an den unterschiedlich langen Linien zu den 
beiden Steuerpunkten zeigt.

• Symmetrischer Punkt: sowohl Richtung als auch Krümmung stimmen in diesem Punkt 
in beiden Richtungen überein; das zeigt sich, indem die beiden Linien zu den 
Steuerpunkten nicht nur die gleiche Richtung haben (also die Tangenten gleich sind), 
sondern auch die Längen übereinstimmen.

Bézierkurven und Polygone | 51



Abbildung 34: Typen von Punkten

Steuerpunkte
Wie schon geschrieben wurde, dienen die Steuerpunkte dazu, durch ihre Richtung und Länge in 
Bezug zum zugehörigen Kurvenpunkt das Verhalten der Kurve zu bestimmen. Möglicherweise 
sehen Sie aber gar nicht viele Steuerpunkte, wie das in Abbildung 35 auf der linken Seite zu 
sehen ist.

Abbildung 35: Steuerpunkte

Es gibt dafür zwei mögliche Gründe, die beide in der Abbildung vorkommen.

• Es stoßen ein gekrümmtes und ein gerades Segment zusammen, wie im zweiten Punkt 
der Kurve. Hier sieht es nur so aus, als ob kein Steuerpunkt vorhanden wäre, denn wenn
Sie genau hinsehen (und deshalb wurde die Abbildung auch vergrößert), sehen Sie, 
dass dem Kurvenpunkt, der durch das Quadrat dargestellt wird, ein Steuerpunkt, 
angezeigt durch einen Kreis, überlagert ist. Der Griff, an dessen Ende der Steuerpunkt 
ist, hat keine Länge und somit auch keine Richtung, d. h. die Form der Kurve wird, 
abgesehen von der Lage der beiden Kurvenpunkte, nur durch den linken Steuerpunkt 
bestimmt.
Sie können den Steuerpunkt mit der Maus etwas aus seiner Position direkt auf dem Qua-
drat herausziehen, dann können Sie auch den Kurvenpunkt auswählen.

• Es stoßen zwei gerade Segmente aneinander, wie z. B. im vierten Punkt. Dann ist 
tatsächlich kein Steuerpunkt vorhanden. Wählen Sie in diesem Fall den Punkttyp 
Eckpunkt aus (s. „Den Typ des Punktes ändern“ auf Seite 58).

Das Ergebnis der beiden Aktionen sehen im rechten Teil der Abbildung 35.

Bézierkurven in LibreOffice
LibreOffice verwendet diesen Begriff in etwas verallgemeinerter Form: es bezeichnet damit auch 
eine Folge von Bézierkurven, die jeweils End- und Anfangspunkte gemeinsam haben. Intern wird
ein solches Objekt auch als Bézierform bezeichnet. Eine solche Folge von Bézierkurven entsteht 
z. B., wenn Sie – wie in „Zeichnen einer Bézierkurve“ auf Seite 53 am Ende bereits 
angesprochen –  in Punkt b)) nach dem Ziehen des Punktes nach links unten nicht doppelt 
klicken. Die Form ist damit noch nicht abgeschlossen, je nachdem, wie Sie die Maus mit oder 
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ohne gedrückte Maustaste weiterbewegen, wird ein weiteres, eventuell lineares Segment 
hinzugefügt; das setzt sich fort, bis Sie doppelklicken.

Dies ist beschrieben in „Zeichnen einer zusammengesetzten Bézierkurve“ auf Seite 54.

Polygone in LibreOffice
Polygone werden in LibreOffice im Prinzip wie Bézierkurven behandelt, die nur gerade Segmente
haben, obwohl bei einem Polygon in der Statusleiste ein Text „Polygon mit n Punkten 
ausgewählt“ angezeigt wird. Es genügt aber schon, dass Sie für eine der Ecken das Symbol 
Eckpunkt aktivieren, und schon ändert sich der Text zu „Punkt von Bézierkurve ausgewählt“ und, 
wenn Sie das Zeichnungsobjekt insgesamt auswählen, zu „Bézierkurve ausgewählt“.

Zeichnen einer Bézierkurve
Abbildung 36, die bereits in Kapitel 2 – Zeichnen von Formen gezeigt wurde, zeigt den Ablauf 
des Zeichnens einer solchen Kurve und einer ersten Änderung. Erst der zweite und dritte Schritt 
lassen erkennen, warum die Linie im ersten Schritt so gezogen wurde.

Abbildung 36: Zeichnen einer Kurve

a) Ziehen Sie eine waagrechte Linie, indem Sie bei  klicken und die Maustaste halten und 
bei  die Taste loslassen

b) Bewegen Sie die Maus nach links unten (der rot angedeutete Pfeil zeigt die Cursor-
bewegung), damit Sie an dem Punkt anlangen, wie die zweite Grafik der Abbildung das 
zeigt. Doppelklicken Sie dann, damit die Kurve abgeschlossen wird.

c) Der dritte Teil der Abbildung zeigt nun die Struktur der erzeugten Kurve: Beginn und Ende
der Kurve haben als Tangente die Geraden, die von den Anfangs- und Endpunkten zu 
dem Punkt  verlaufen. Die Linie, die Sie in a)) gezeichnet haben, entspricht der 
Tangente im Steuerpunkt . Der Anfangspunkt der Kurve ist durch ein etwas größeres 
Quadrat gekennzeichnet.

d) Die Kurve ist nun ein flächiges Objekt. Wenn Sie sie anklicken, dann erscheinen acht 
Bearbeitungspunkte, die das umfassende Rechteck repräsentieren; Sie können dann die
Breite und Höhe der Kurve verändern (s. Kapitel 3 – Objekte und Objektpunkte). Wenn 
Sie jedoch die Form der Kurve verändern wollen, dann müssen Sie über Kontextmenü 
► Punkte oder über die Symbolleiste Standard und das Symbol Punkte oder die Taste 
F8 die Bearbeitung der Punkte der Kurve einschalten.
Zunächst zeigt der Cursor als Symbol den Pfeil und ein Quadrat, wenn der Mauszeiger 
sich einem Endpunkt nähert, als Zeichen, dass der Punkt verschoben wird, wenn Sie ihn 
anklicken und die Maus bewegen.
Wenn Sie allerdings einen Endpunkt der Kurve anklicken und die Maustaste loslassen, 
erscheint ein Griff mit einer Linie zu diesem Endpunkt; dies ist im Teil d) dieser Abbildung
durch eine manuell erzeugte Linie beim Anfangspunkt simuliert. Der Endpunkt des Griffs 
(bei ) wird Steuerpunkt genannt, weil er das Verhalten der Kurve in diesem Endpunkt 
steuert.
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Durch eine Änderung der Richtung dieser Linie ändert sich die Austrittsrichtung der 
Kurve, die Länge der Linie bestimmt die Krümmung.

e) Bei der neu erzeugten Kurve ist der Endpunkt (nun im Sinne des Zeichnens: das „Ziel“, 
das durch ein kleineres Quadrat gekennzeichnet ist) – im Gegensatz zum Anfangspunkt 
– zunächst einmal ohne Griff. Das liegt daran, dass die Kurve aufgrund ihrer Entstehung 
nur einen Steuerpunkt besitzt; Sie haben ja nur durch das Klicken an der mit  
markierten Stelle einen Punkt gesetzt. Damit auch die Möglichkeit besteht, das Verhalten
der Kurve in diesem Endpunkt zu verändern, ist ein zweiter Griff und damit ein 
Steuerpunkt vorgesehen. Er liegt allerdings genau auf dem Endpunkt, was man bei 
genauem Hinschauen auch bemerken kann: vergrößern Sie das Dokument, dann 
können Sie sogar in der Abbildung erkennen, dass vor dem hellbraun gezeichneten 
Quadrat ein blauer Kreis liegt. Wenn Sie auf diesen Endpunkt zeigen, ändert sich das 
Cursor-Symbol zu dem, das auch noch in der Abbildung zu sehen ist, was bedeutet, 
dass Sie es mit einen Griff oder Steuerpunkt zu tun haben; wenn Sie nun mit gedrückter 
Maustaste die Maus bewegen, wird die Grifflinie sichtbar, und Sie können die Richtung, 
mit der die Kurve den Endpunkt verlässt, sowie die Form der daraus resultierenden 
Kurve bestimmen.
Den Punkt zu verschieben, ohne den Steuerpunkt/Griff zu bewegen, ist mit der Maus 
äußerst schwierig, wenn Sie das wirklich benötigen sollten, verwenden Sie am besten 
die Vorgehensweise ohne Maus, die in „Auswählen und Bewegen von Punkten ohne 
Maus“ auf Seite 56 beschrieben wird.

Wenn Sie in b) nicht doppelklicken, können Sie die Kurve weiter zeichnen, dies wird im nächsten 
Abschnitt beschrieben.

Zeichnen einer zusammengesetzten Bézierkurve
Wenn Sie beim Zeichnen einer Kurve wie im vorigen Abschnitt beschrieben nicht mit Doppelklick 
abschließen, können Sie der Kurve weitere Segmente hinzufügen. Hier haben Sie zwei 
prinzipielle Möglichkeiten, die Sie auch hintereinander kombinieren können:

• Sie klicken einfach und bewegen anschließend die Maus weiter, ohne dass die 
Taste Strg  gedrückt ist: dann werden bei jedem Klick gerade Linienstücke erzeugt, die 
aber immer noch Bézierkurven sind; wie Sie diese weiter behandeln, wird in „In Kurve 
umwandeln“ auf Seite 58 beschrieben.

• Sie klicken nicht, sondern bewegen die Maustaste mit gedrückter Taste Strg . Dieses 
Vorgehen entspricht dem beim Zeichnen des ersten Segments verwendeten, wird aber 
im Folgenden noch einmal im Zusammenhang näher dargestellt.

Abbildung 37 zeigt das Vorgehen für eine Bézierkurve mit zwei Segmenten.

Abbildung 37: Bézierkurve mit zwei Segmenten

a) zeigt die Kurve, wie sie nach dem vorigen Abschnitt vorliegt, bevor ein Doppelklick sie 
abschließt.

b) Mit gedrückter Maustaste wurde die Maus bewegt; das erzeugt einen neuen Kurvenpunkt
und einen neuen Steuerpunkt, der aber noch nicht als solcher mit einem Kreis sichtbar 
gemacht wird, Sie sehen nur die zugehörige Linie, deren Richtung und Länge die 
Austrittsrichtung und Krümmung der Kurve in diesem Kurvenpunkt bestimmt.
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c) Wird die Maustaste losgelassen und die Maus weiterbewegt, so wird die Kurve aufgrund 
der vorhandenen Vorgaben zunächst provisorisch fortgeführt.

d) Wenn Sie nun doppelklicken, wird das Zeichnen abgeschlossen, die Kurve wird mit ihren 
Kurvenpunkten dargestellt.
Sie können alternativ wieder mit dem Schritt b)) weitermachen oder durch einfachen 
Klick und Ziehen mit der Maus ein lineares Segment einfügen.

Dieses auf den ersten Blick vielleicht verwirrende Verhalten kann man wie folgt zusammenfassen
(gilt ab dem Zeichnen des ersten Segments wie in a)):

• Klicken und anschließendes Ziehen mit der Maus erzeugt ein lineares Segment

• Ziehen bei gedrückter Maustaste erzeugt einen Steuerpunkt mitsamt zugehöriger Linie; 
Loslassen der Maus fixiert diese Linie und erzeugt ein neues Kurvensegment.

In beiden Fällen wird ein Kurvenpunkt erzeugt. Dieser ist zunächst ein symmetrischer Punkt (s. 
„Kurvenpunkte“ auf Seite 51), weil das in den meisten Fällen die richtige Wahl sein wird; Sie 
können das natürlich anschließend ändern.

Wenn Sie sich beim Anwenden dieser Regeln vertan haben und ein lineares Segment erzeugt 
haben, können Sie das nachträglich noch ändern: „Umwandlung eines geraden Segments in 
eine Kurve“ auf Seite 58 beschreibt das nötige Vorgehen.

Bézierkurven im Punkt-Modus bearbeiten
Bézierkurven werden zur Modellierung von gekrümmten Kurven verwendet. In Kapitel 2 – 
Zeichnen von Formen wurde bereits gezeigt, wie eine Bézierkurve gezeichnet werden kann, die 
Anleitung wird hier als Einstieg wiederholt.

Wenn eine Bézierkurve einfach ausgewählt ist, verhält sie sich wie andere Zeichnungsobjekte: 
Sie können sie z. B. verschieben oder ihre Größe ändern. Wenn Sie die speziellen 
Kurveneigenschaften ändern wollen, müssen Sie die Steuerpunkte aktivieren. Sie haben dazu 
folgende Möglichkeiten:

• Betätigen Sie die Taste F8 .

• Wählen Sie Bearbeiten ► Punkte.

• Wählen Sie das Symbol Punkte der Standardsymbolleiste.

Diese Aktionen versetzen Draw in den Punkt-Modus, er bleibt solange erhalten, bis Sie erneut 
eine dieser Aktionen ausführen. Wenn der Punkt-Modus aktiv ist, bewirkt ein Auswählen einer 
Bézierkurve deshalb die Anzeige der Punkte dieser Kurve und nicht die einfach Auswahl des 
Objekts.

Solange der Punkt-Modus aktiv ist, wird normalerweise auch die Symbolleiste Punkte bearbeiten 
(Abbildung 38) angezeigt; sollte das nicht der Fall sein, können Sie sie über Ansicht ► 
Symbolleisten ► Punkte bearbeiten aktivieren.

Normalerweise werden immer nur die Steuerpunkte und die zugehörige Linien angezeigt, die zu 
dem ausgewählten Kurvenpunkt gehören. Sie können aber die Anzeige aller Steuerpunkte 
veranlassen, indem Sie Im Punkt-Modus die gesamte Kurve (oder einen Teil davon) mit der 
Maus einrahmen oder die Tastenkombination Strg  + A  verwenden. Wenn Sie dann Esc  
betätigen, wird dieser Modus wieder beendet, das Objekt geht in den Punkt-Modus zurück. Auch 
wenn Sie woandershin klicken, ist dieser Modus beendet.

Wenn Sie die Steuerpunkte und -linien grundsätzlich sehen wollen, sobald Sie den Punkt-Modus 
aktivieren, können Sie das über Extras ► Optionen ► LibreOffice Draw ► Ansicht ► Alle 
Steuerpunkte im Bézier-Editor einschalten.
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Abbildung 38: Die Symbolleiste „Punkte bearbeiten“

In diesem Modus können Sie einen oder mehrere Punkte (mit zusätzlicher Umschalt -Taste) 
durch Anklicken zur Bearbeitung aktivieren.

Das Symbol Punkte bearbeiten (links oben in den aufgelisteten Beschreibungen) ist 
üblicherweise ausgeblendet, da die Symbolleiste ja ausgeblendet wird, wenn der Punkt-Modus 
verlassen wird. Sie können für besondere Fälle das Symbol aber einblenden über das Menü, das
Sie über die Schaltfläche ▼ erreichen: wählen Sie dort Sichtbare Schaltflächen ► Punkte 
bearbeiten.

Das Symbol Punkte verschieben ist normalerweise bereits aktiv und wird auch meist nach 
anderen Aktionen wieder aktiviert, in Sonderfällen kann es nötig sein, es manuell wieder zu 
aktivieren.

Die weiteren Symbole werden in den folgenden Abschnitten behandelt.

Auswählen und Bewegen von Punkten mit der Maus
Im Allgemeinen können Sie einen Punkt einfach anklicken und dann verschieben oder auf 
andere Weise bearbeiten. Schwierigkeiten macht bloß ein Kurvenpunkt, der von einem 
Steuerpunkt überdeckt wird (s. „Steuerpunkte“ auf Seite 52). Wenn Sie den Steuerpunkt nicht 
verschieben wollen, ist es mit der Maus sehr schwierig, den Kurvenpunkt auszuwählen, denn 
meist ist der Steuerpunkt im Fokus, wie Sie am Cursorsymbol mit der angedeuteten Bézierkurve 
erkennen; nur wenn der Cursor als Ergänzung das kleine Quadrat zeigt, was nur schwer zu 
erreichen ist, wenn Sie sich geschickt einer Ecke nähern, können Sie den Kurvenpunkt 
auswählen oder verschieben.

Wenn Sie den Punkt nicht verschieben wollen, sondern anderweitig bearbeiten, kann es etwas 
nützen, ihn durch Einrahmen mit der Maus auszuwählen. Hier werden jedoch  nicht immer alle 
möglichen Symbole aktiviert, man muss das eventuell mehrfach wiederholen.

Eine Alternative ist, in diesem Fall ohne Maus zu arbeiten, wie es im folgenden Abschnitt 
beschrieben wird.

Auswählen und Bewegen von Punkten ohne Maus
Um ohne Maus einen (Kurven- oder Steuer-) Punkt bearbeiten zu können, gehen Sie folgender-
maßen vor:

1. Betätigen Sie so oft Strg+Tab  (oder Strg+Umschalt+Tab  für die umgekehrte Richtung),
bis der gewünschte Punkt erreicht ist; er blinkt, indem die Umrandung des Quadrats ver-
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schwindet und wieder auftaucht.
In diesem Zustand können Sie bereits den Kurvenpunkt mit den Pfeiltasten verschieben.

2. Betätigen Sie dann Strg+Leertaste , um ihn für die weitere Bearbeitung zu aktivieren. 
Das Quadrat ändert seine Farbe, und ggf. erscheint der Steuerpunkt zur Bearbeitung der
Richtung und Krümmung der Kurve im gewählten Kurvenpunkt.

3. Diesen Steuerpunkt können Sie dann durch ein weiteres Strg+Tab  oder 

Strg+Umschalt+Tab  aktivieren, um ihn dann mit den Pfeiltasten verschieben zu 
können.

Wenn Sie weitere Punkte aktivieren wollen, müssen Sie jeweils Umschalt+Leertaste  

verwenden, Strg+Leertaste  aktiviert nur den gerade ausgewählten Punkt und deaktiviert die 
zuvor aktivierten.
Eine erneute Anwendung von Umschalt+Leertaste  deaktiviert einen aktivierten Punkt.

Wenn der Kurvenpunkt von einem Steuerpunkt überdeckt wird, wird zunächst der Steuerpunkt 
ausgewählt, was Sie daran erkennen, dass das blinkende Objekt ein Kreis ist. Wenden Sie dann 
einfach Strg+Tab  oder Strg+Umschalt+Tab, je nachdem, aus welcher Richtung Sie gekommen
sind, ein weiteres Mal an, um den Kurvenpunkt auszuwählen; Sie sehen dann, dass ein Quadrat 
blinkt. Dann können Sie den Kurvenpunkt genauso wie in Punkt 3 aktivieren.

Formänderung
Um die Form einer Kurve zu ändern, wählen Sie den betroffenen Kurvenpunkt aus. Dann können
Sie einerseits den Punkt verschieben. Andererseits können Sie durch Verschieben des zugehöri-
gen Steuerpunkts den Austritt der Kurve aus dem Kurvenpunkt und damit auch ihren weiteren 
Verlauf verändern:

• Die Richtung der Linie zwischen Kurven- und Steuerpunkt beeinflusst die 
Austrittsrichtung der Kurve im Kurvenpunkt; die Linie ist die Tangente der Kurve in 
diesem Punkt.

• Die Länge der Linie bestimmt die Krümmung der Kurve: je länger die Linie, desto 
schwächer die Krümmung.

Punkte einfügen
Hier gibt es zwei Vorgehensweisen, bei denen die eine schneller, aber eventuell ungenauer ist, 
die andere etwas aufwändiger, aber vor allem auch ohne Maus ausführbar ist. Gemeinsam ist 
beiden, dass Sie zunächst in der Symbolleiste Punkte bearbeiten das Symbol Punkte einfügen 
auswählen müssen.

• Der Mauszeiger wandelt sich in ein Fadenkreuz; zeigen Sie bei gedrückter Maustaste auf
die Stelle in der Kurve, wo ein neuer Punkt eingefügt werden soll, bewegen Sie anschlie-
ßend die Maus, bis ein anderes Phantombild der Kurve gezeigt wird, und lassen Sie die 
Maustaste los.
Die Kurve hat nun leider einen andern Verlauf als vorher, den Sie nun eventuell wieder 
korrigieren müssen, aber offenbar gibt es keinen anderen Weg, einen Punkt über die 
Mausbewegung einzufügen.

• Verwenden Sie Umschalt+Pfeiltasten, um den Cursor an die gewünschte Stelle zu 

bewegen. Verwenden Sie nun Umschalt+Eingabe , um den Punkt auszuwählen. 

Verwenden Sie weiter Umschalt+Pfeiltaste, um den Punkt etwas zu verschieben. 

Wählen Sie nun Umschalt+Eingabe , um die Erzeugung des Punktes abzuschließen.

Der eingefügte Punkt ist zwar ein glatter Punkt, aber nicht unbedingt symmetrisch (s. 
„Kurvenpunkte“ auf Seite 51).
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Punkte löschen
Das Vorgehen ist wie zu erwarten:

1. Wählen Sie den Punkt zur Bearbeitung aus (gelbe Markierung).

2. Betätigen Sie das Symbol Punkte löschen der Symbolleiste Punkte bearbeiten oder 
verwenden Sie die Taste Entf .

Den Typ des Punktes ändern
Die drei möglichen Typen von Punkten wurden in „Kurvenpunkte“ auf Seite 51 vorgestellt. 
Zwischen den Typen wechseln Sie, indem Sie im Punkt-Modus den Kurvenpunkt auswählen und 
dann aus den Symbolen Eckpunkt setzen, Glatter Übergang und Symmetrischer Übergang das 
gewünschte auswählen.

In Kurve umwandeln
Dieses Symbol schaltet ein oder aus:

• Ist das betroffene Segment eine Gerade, wird sie in eine Kurve umgewandelt. Die Kurve 
sieht zunächst immer noch gerade aus, hat aber nun zwei Steuerpunkte, die Ihnen alle 
Möglichkeiten einer Bézierkurve vom Grad 3 bieten.

• Ist das betroffene Segment eine Kurve, dann wird sie in eine Gerade verwandelt, die 
keine Steuerpunkte mehr zeigt.

Da das Segment aber immer noch eine Bézierkurve ist, ist auch eine Änderung in eine Gerade 
reversibel.

Um die Umwandlung in eine Kurve anzustoßen, müssen Sie den Kurvenpunkt am Anfang dieses 
Segments auswählen; wo der Anfang des Segments liegt, bestimmt sich durch den Anfang der 
gesamten Kurve, und den erkennen Sie am größeren Quadrat im Vergleich zu den Quadraten 
der restlichen Kurvenpunkte. Dementsprechend ist das Symbol genau dann aktiviert, wenn nicht 
der letzte Punkt der Bézierkurve ausgewählt ist. 

Wenn Sie mehrere Kurvenpunkte ausgewählt haben, werden alle zugehörigen Segmente in 
Kurven (oder Geraden) umgewandelt.

Ein Hauptanwendungsfall für diese Funktion dürfte sein, Fehlbedienungen beim Einfügen einer 
Bézierkurve zu korrigieren, denn es passiert leicht, dass man nach dem Einfügen des ersten 
Segments den Mauszeiger weiterbewegt, ohne die Umschalt-Taste zu drücken, was das nächste
Segment als Gerade erzeugt. Der folgende Fall soll zur Demonstration des Vorgehens dienen.

Umwandlung eines geraden Segments in eine Kurve

Abbildung 39: Umwandlung einer Geraden in eine Kurve
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1. Die Abbildung 39 zeigt links einen typischen Fall, ein erstes Segment einer Bézierkurve 
wurde erzeugt, anschließend wurde aber die Maus ohne Umschalt -Taste bewegt; als 
dies erkannt wurde, wurde die Kurve mit Doppelklick abgeschlossen. Nun soll auch das 
zweite Segment als Kurve verwendbar sein.

2. Die Handhabung ist nun nicht ganz einfach, denn Sie müssen den zweiten Kurvenpunkt 
aktivieren, um die Umwandlung in eine Kurve ausführen zu können. Das Problem ist, 
dass, wie in „Steuerpunkte“ auf Seite 52 bereits beschrieben, diesem Kurvenpunkt ein 
Steuerpunkt überlagert ist. Wie Sie diesen Punkt aktivieren können, wurde in „Auswählen
und Bewegen von Punkten mit der Maus“ auf Seite 56 und „Auswählen und Bewegen 
von Punkten ohne Maus“ auf Seite 56 beschrieben.

3. Betätigen Sie nun das Symbol In Kurve umwandeln. Als Ergebnis sehen Sie, dass zwei 
Steuerpunkte erzeugt wurden, die zunächst einmal in Richtung der Geraden liegen, die 
Sie aber zur beliebigen Verformung der Kurve (im Rahmen einer Bézierkurve vom Grad 
3) verwenden können.

4. Die beiden Steuerpunkte können Sie nun verschieben, um dem Kurvenstück die 
gewünschte Form zu geben.

Alternative Umwandlung in eine Kurve
Sie können das Ziel einer Umwandlung einer Geraden in eine Bézierkurve des Grades 3 auch 
auf anderem Wege erreichen.

Abbildung 40: Behandlung linearer Segmente ohne Umwandlung in Kurve

a) Das Ausgangsobjekt ist das gleiche wie in Abbildung 39.

b) Wählen Sie den Kurvenpunkt aus (ohne Maus müssen Sie ihn zusätzlich durch 
Strg+Leertaste  oder Umschalt+Leertaste  aktivieren) und wählen Sie dann das Symbol 
Eckpunkt setzen der Symbolleiste Punkte bearbeiten (s. Abbildung 38). Der Steuerpunkt 
erscheint, das Maussymbol ändert sich durch Hinzufügen des stilisierten Bilds einer 
Bézierkurve.

c) Nun können Sie den Steuerpunkt verschieben und damit die Kurve verändern.

d) Das gleiche können Sie für den anderen Endpunkt der bisherigen geraden Linie tun.

Geschlossene Bézierformen
Die Symbolleiste Zeichnung bietet für Bézierkurven je ein Symbol für ungefüllte und für gefüllte 
Formen an. Eine gefüllte Form kann schnell ein sehr verwirrendes Bild ergeben, wie 
Abbildung 41 zeigt. Es sieht wie eine ziemlich willkürlich erzeugte Form aus, die Anzahl der 
Steuerpunkte im rechten Teil zeigt aber, dass sie immer noch weniger komplex ist, als ihr Abbild 
erscheinen lässt.

Die Färbung der durch die Kurvensegmente definierten Flächen folgt der Logik, wie sie in Kapitel
5 – Behandlung mehrerer Objekte dieses Handbuchs beschrieben wurde: Ergibt sich die Fläche 
durch eine ungerade Anzahl von Überlagerungen von Teilflächen, die durch die Kurven erzeugt 
werden, so wird die Fläche gefüllt, bei einer geraden Anzahl bleibt die Fläche ungefüllt; bei den 
weißen Flächen links oben und rechts ist das noch einigermaßen gut erkennbar.
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Abbildung 41: Eine geschlossene Bézierform, rechts mit allen Steuerpunkten

Eine nicht geschlossene Bézierform  kann durch das Symbol Bézier schließen oder 
Kontextmenü ► Objekt schließen in eine geschlossene Form überführt werden. Zwischen 
Endpunkt und Anfangspunkt des Bézierkurvenzugs wird dann eine gerade Linie gezeichnet (die 
Sie anschließend bei Bedarf wieder in eine Kurve umwandeln können), und das Objekt erhält 
eine Füllfarbe (wenn Sie nicht etwas anderes als Standard gesetzt haben).

Wenn Sie beim Zeichnen einer Form den letzten Punkt hinreichend nahe an den Anfangspunkt 
platzieren, wird die Form geschlossen, auch wenn Sie den Anfangspunkt nicht exakt getroffen 
haben. Das mag für die vordergründige Optik ausreichend sein, aber nicht unbedingt im Sinn 
einer klaren Definition der Objekte. Verwenden Sie daher eventuell lieber den Befehl Bézier 
schließen anstatt eines manuellen Positionieren des Endpunkts, weil dies nicht unbedingt exakt 
den Anfangspunkt trifft.

Abbildung 42 zeigt ein Dreieck, das als Polygon (ungefüllt) begonnen wurde; nachdem der 
Endpunkt ziemlich nahe am Anfangspunkt lag, hat LibreOffice das Polygon geschlossen.

Abbildung 42: leicht verschobener Endpunkt eines Linienzugs

Allerdings ist das Polygon nun nicht einfach, wie es auf den ersten Blick aussieht, ein Dreieck: 
Eine Vergrößerung der linken oberen Ecke (mittleres Bild) zeigt, dass es sich um zwei getrennte 
Punkte handelt. Eine weitere Vergrößerung der linken oberen Ecke (rechts) zeigt, dass diese 
Punkte sich in beiden Koordinaten-Richtungen unterscheiden. Wenn Sie auf die Eigenschaften 
der Punkte schauen, stellen Sie allerdings möglicherweise fest, dass die Werte der Position 
exakt die gleichen sind.

Um diese schwierig zu meisternden Probleme zu vermeiden, empfiehlt sich daher dringend, das 
Schließen der Kurve über das genannte Symbol oder den Befehl aus dem Kontextmenü auszu-
führen.

Bei eingeschalteter Einstellung Am Raster fangen mag das gezeigte Platzieren des Endpunkts 
möglicherweise den Anfangspunkt exakt treffen.
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Punkte reduzieren
Hiermit schalten Sie einen Modus ein, der hauptsächlich für Polygonzüge relevant ist. Wenn 
dieser Modus aktiv ist, können Sie Punkte des Polygonzugs entfernen, indem Sie sie genügend 
nahe an die gedachte Gerade zwischen ihren zwei Nachbarpunkten bringen. Sie können somit 
eine geknickte Linie in eine Gerade überführen.

Schalten Sie diesen Modus ein und wählen Sie den Punkt zur Bearbeitung aus, den Sie 
entfernen wollen. Verschieben Sie ihn bei gedrückter Maustaste – wobei immer Phantomlinien zu
seinen Nachbarpunkten sichtbar sind – bis die Phantomlinien in eine Gerade übergehen; lassen 
Sie dann die Maustaste los. Der Punkt ist danach verschwunden.

Vorsicht

Achten Sie darauf, dass dieser Modus ausgeschaltet ist, wenn Sie auf einer geraden
Linie einen Punkt einfügen wollen, denn sonst wird dieser sofort nach dem Einfügen 
wieder gelöscht, falls Sie ihn nicht schon während des Einfügens genügend weit von
der Geraden wegführen.

Den Bereich, in dem die geknickte Linie von einem Punkt zu seinen zwei Nachbarpunkten in die 
Gerade übergeht, können Sie durch die Angabe eines Winkels über Extras ► Optionen ► 
LibreOffice Draw ► Raster bestimmen, der zugehörige Parameter heißt Punktreduktion. Die 
Standardeinstellung ist 15°. Die Auswirkung einer Änderung dieses Winkels ist nicht auf den 
ersten Blick ersichtlich, anhand der Abbildung 43 soll versucht werden, den Mechanismus zu 
erklären.

Abbildung 43: Der Bereich, in dem Punktreduktion auftritt

Der Linienzug ACB sei Teil eines Polygons, dessen Fortsetzung durch die roten Linien, die von A 
und B ausgehen, angedeutet wird. Wie schon geschrieben wurde, klappt der Linienzug ACB in 
eine gerade Linie zwischen A und B um, wenn der Punkt C sich genügend der Linie AB nähert. 
Die exakte Grenze ist die folgende: Wenn die Summe der Winkel zwischen AB und AC 
(bezeichnet durch α) und zwischen AB und BC (bezeichnet durch β) kleiner als der eingestellte 
Parameter, also im Standard 15°, ist, wird aus dem Linienzug eine Gerade, und der Punkt 
verschwindet. Ein möglicher Grenzpunkt ist in Abbildung 43 durch C‘ angedeutet. Man kann die 
Bedingung auch äquivalent formulieren als: Wenn der Winkel γ im Punkt C bzw. C‘ größer als 
180° minus den eingestellten Parameter, wenn er also bei der Standardeinstellung mindestens 
165° beträgt, wird der Linienzug in eine Gerade überführt.

Aus mathematischen Gründen ergibt sich, dass der Bereich, in dem ein Linienzug in eine Gerade
umgewandelt wird, ein Kreissektor ist, der durch die Punkte A und B geht; er ist in Abbildung 43 
durch eine gelbe Hinterlegung ersichtlich; die Radien des Kreises, die von A und B ausgehen, 
sind durch gestrichelte Linien angedeutet.

Kurve auftrennen
Eine Bézierkurve, die aus mehreren Segmenten besteht, können Sie in einzelne Bézierkurven 
zerlegen, indem Sie den Kurvenpunkt, an dem die Kurve getrennt werden soll, zur Bearbeitung 
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auswählen und anschließend Kurve auftrennen auswählen. Sie können anschließend die so 
getrennten Teile des vorigen Objekts getrennt bearbeiten oder verschieben. Sie müssen dazu 
allerdings erst die Kurve deselektieren und dann den Teil der Kurve erneut selektieren, den Sie 
verschieben möchten.
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